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Presentacion

Esta publicacidn tiene como objetivo exponer el funcionamiento del programa
ProjectLibre y abordar sus funcionalidades para planificar y programar un pro-
yecto en el entorno de la gestion de proyectos y controlar su seguimiento, de
principio a fin.

En primer lugar, expone una vision general de los fundamentos de la gestion de
proyectos, a continuacion, presenta el funcionamiento del programa y sus capa-
cidades y, por ultimo, propone diferentes actividades para aplicar y adquirir los
contenidos tedricos expuestos.

Los diferentes apartados del documento se desarrollan siguiendo la secuencia
de los grupos de procesos propuesta por el pmvBok (Project Management Body of
Knowledge o Guia de los fundamentos de la direccion de proyectos) que estruc-
tura el ciclo de vida de un proyecto desde la etapa de inicio y planificacion hasta
la etapa final de evaluacion de resultados.
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1. Introduccion a la gestion
de proyectos

1.1. La gestion de proyectos

De acuerdo con la Guia de los fundamentos de la direccion de proyectos (PMBOK,
Project Management Body of Knowledge), un proyecto puede definirse como un
esfuerzo temporal desarrollado por personas o entidades, con un principio y final
definidos, con el fin de alcanzar un objetivo vinculado con la creacién de un pro-
ducto, servicio o resultado unico.

Los proyectos implican la utilizacion coordinada de recursos de diferente natu-
raleza (de trabajo y materiales) para el desarrollo de tareas interrelacionadas entre
si. Dichas tareas son actividades coordinadas y controlables periédicamente, con
limites temporales propios, cuyo desarrollo permite alcanzar el logro de los obje-
tivos del proyecto. Los recursos de un proyecto suelen ser limitados, por lo que su
adecuada gestion estd directamente relacionada con el éxito del proyecto.

La adecuada gestion de un proyecto, medida en términos de tiempo-coste,
implica la optimizacion de los procesos que lo configuran, desde la conceptuali-
zacion del proyecto hasta su evaluacion final tras el cierre. La norma UNE-ISO
21500 define la gestion de proyectos (o Project Management) como la aplicacion
de métodos, herramientas, técnicas y competencias a un proyecto. La direccion y
gestion de proyectos incluye la integracion de las diversas fases del ciclo de vida
del proyecto y se lleva a cabo mediante procesos. Dicha norma propone cinco
grupos de procesos: inicio, planificacion, implementacion, control y cierre, que
son independientes del tipo de proyecto desarrollado y pueden agruparse en tres
grandes etapas que determinan el desarrollo de un proyecto. La figura 1 refleja
la interaccion entre los grupos de procesos y las etapas, las cuales se describen a
continuacion:

e FEtapa I: ideacion y planificacion del proyecto. Incluye los procesos de inicio
y planificacion. Esta etapa se basa en definir los objetivos y el plan base del
proyecto con el fin de establecer cada una de las tareas y recursos que lo
conforman, sus caracteristicas, interdependencias y requisitos, asi como las
restricciones temporales, materiales y econdmicas en las que debe desarro-
llarse el proyecto.
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Etapa II: ejecucion y supervision del proyecto. Incluye los procesos de im-
plementacion y control. En esta etapa el proyecto planeado se ejecuta, pu-
diéndose dar cambios y variaciones con respecto al plan base inicial. Estas
variaciones deben ser monitorizadas con el fin de facilitar la pronta imple-
mentacion de medidas, tras una desviacion, que permitan reconducir el de-
sarrollo del proyecto con el fin de garantizar el logro de los objetivos.
Etapa Il finalizacion y evaluacion del proyecto. Incluye el proceso final
de cierre del proyecto y requiere la evaluacion de los resultados y los logros
alcanzados. La evaluacion del proyecto facilita la comunicacion de los re-
sultados operativos y financieros obtenidos, tanto a las personas ejecutoras
como a las responsables del proyecto.
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Figura 1.
Relacion entre los grupos de procesos y las etapas de un proyecto

Cabe senalar que los flujos de informacion generada en cada proceso durante el
desarrollo de un proyecto no solo sirven como base para el desarrollo de procesos
futuros, sino que también retroalimentan los procesos anteriores, tal y como mues-
tra la figura 1.

1.2. Técnicas

La

realizacion de un proyecto es un proceso complejo, susceptible de descom-

ponerse en una serie de tareas interdependientes entre si en cuanto a su orden de
ejecucion. Como se ha introducido anteriormente, el primer proceso de la gestion
de proyectos, una vez que los objetivos que se pretenden alcanzar con el mismo ya
han sido establecidos, es su planificacion. Planificar implica:
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Estructurar los objetivos en fases y tareas.

Establecer la secuencia de las tareas, es decir, las prioridades por dependen-
cia de tareas.

Estimar la duracion de las tareas.

Definir los recursos necesarios para llevar a cabo cada una de las tareas.



La planificacion proporciona una vision anticipada del desarrollo del proyecto
y de los posibles problemas que pueden sucederse y es un proceso continuo que
debe revisarse periddicamente, por si se producen cambios que puedan influir en
la consecucion del proyecto.

En ocasiones, el término de planificacion se confunde o se utiliza como si-
nénimo de programacion, sin embargo, estos no son lo mismo. La planificacion
se encarga de estructurar las tareas a realizar dentro del proyecto, definiendo la
duracién y el orden de ejecucion de las mismas, mientras que la programacion se
encarga de la transformacion de la planificacion en un calendario real, teniendo en
cuenta aspectos como son los recursos disponibles, la carga de trabajo o el coste,
entre otros. Actualmente, unicamente en proyectos de gran tamafio o envergadura
suele hacerse una distincion clara entre planificacion y programacion.

La planificacion no es un cometido sencillo y, para ello, existen diferentes téc-
nicas que contribuyen a la gestion de proyectos. La técnica o método de plani-
ficacién mas sencillo y cominmente utilizado es el diagrama de Gantt, el cual
representa mediante un grafico de barras la duracion temporal de cada una de las
actividades a realizar. Se trata de un diagrama bidimensional en el que se repre-
sentan las diferentes actividades o tareas del proyecto (en el eje vertical), frente al
calendario del proyecto (en el eje horizontal), determinando el tiempo necesario
para realizarlas. Cada una de las actividades del proyecto se muestra en el dia-
grama mediante una barra horizontal cuyo extremo izquierdo representa la fecha
de comienzo de dicha actividad y su longitud, la duracion de dicha actividad. La
figura 2 muestra, conceptualmente, un ejemplo de diagrama de Gantt.

Calendario (horas, dias, semanas, meses, aiios, etc.)

Mes 1 Mes 2 Mes 3

Sem1l | Sem2 | Sem3 | Sem4 Sem5 | Semé6 | Sem7 | Sem8 Sem9 | Sem10 | Sem11l |

Actividad 1

Recurso 1, Recurso 3
Actividad 2 I: Recurso 3

Actividad 3 Recurso 5

Actividad 4

Recurso 1, Recurso 2
Actividad 5 E Recurso 2

Actividad 6 P> Recurso 5

Figura 2.
Representacion del diagrama de Gantt

Los diagramas de Gantt son sencillos de realizar y de interpretar, y su proceso
de elaboracion puede resumirse en los siguientes pasos:

1. Determinacion de las tareas o actividades principales.

2. Estimacion de la duracion efectiva de cada tarea.

3. Representacion grafica de la duracion mediante una barra recta, desde la
fecha de inicio a fin.
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4. Establecimiento de las dependencias entre tareas.
5. Distribucion de las duraciones a la escala de dias del calendario.

Para mejorar la interpretacion del diagrama de Gantt, puede utilizarse un codi-
go de colores para la representacion de las barras, por ejemplo, por departamen-
tos o individuos implicados, y se puede disponer sobre cada barra la informacion
relativa a los recursos materiales o humanos necesarios para realizar la actividad
correspondiente.

Por otro lado, si la duracion de las actividades es conocida y se asume la hipo-
tesis de que se dispone de todos los recursos necesarios para desarrollar el proyec-
to (procedimientos, tecnologia y herramientas), existen otras dos técnicas muy
similares entre si y agrupadas bajo el término genérico de andlisis de redes: cpm
(Critical Path Method, o Anélisis del Camino Critico) y PERT (Program Evaluation
and Review Technique, o Evaluacion de Programa y Técnicas de Revision), como
mejora del primero.

El grafismo de cualquier técnica de andlisis de red es el diagrama de flechas,
que sustituye al diagrama de Gantt. Los diagramas de flechas no se dibujan con
ninguna escala lineal, sino que Unicamente representan la interdependencia de
una actividad frente a las demas del proyecto. Este diagrama es comun tanto para
el método cpm como para el método pErRT, como muestra la figura 3 a modo de
ejemplo.

Actividad 1 Actividad 2 Actividad 3

Duracién: x dias Duracién: x dias Duracién: x dias

Inicio: Fin: Inicio: Fin: Inicio: Fin:
dd/mm/aa dd/mm/aa dd/mm/aa dd/mm/aa dd/mm/aa dd/mm/aa

Actividad 6 Actividad ...

Duracién: x dias Duracién: x dias

Inicio: Fin: Inicio: Fin:
dd/mm/aa dd/mm/aa dd/mm/aa dd/mm/aa

Actividad 4 Actividad 5

Duracién: x dias Duracién: x dias

Inicio: Fin: Inicio: Fin:
dd/mm/aa dd/mm/aa dd/mm/aa dd/mm/aa

Figura 3.
Representacion del diagrama de red

La diferencia fundamental entre ambas técnicas es el procedimiento seguido
para determinar la duraciéon de cada una de las actividades. En el método cpm el
procedimiento es determinista, mientras que en el PERT es aleatorio. Ambos mé-
todos sirven para determinar el camino critico del proyecto y las holguras de las
tareas. El camino critico es la secuencia de tareas cuyo retraso provoca la demora
general del proyecto y determina el tiempo minimo en que se puede realizar dicho
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proyecto. El concepto de holgura se refiere al tiempo que puede prolongarse una
tarea sin que la duracion total del proyecto experimente retraso.

1.3. Herramientas

Las herramientas de gestion de proyectos son softwares informaticos que facili-
tan la administracion eficaz y flexible de los proyectos. Estas herramientas permi-
ten crear y programar tareas a lo largo del tiempo, administrar recursos, controlar
los costes, monitorear, realizar el seguimiento y actualizar las tareas programadas
en tiempo real y, finalmente, obtener informacion para la generacion de informes
y la realizacion de analisis de la evolucion y resultados del proyecto.

En este entorno y en particular, ProjectLibre consituye un sofiware de coédigo
abierto para la gestion de proyectos que ofrece las capacidades anteriores en un
entorno de trabajo amigable y que opera de acuerdo con la metodologia propuesta
por el puBok. La figura 4 integra, en cada uno de los procesos de un proyecto vistos
anteriormente, la aportacion de ProjectLibre.

Seguimiento o monitorizacién

ProjectLibre”
- CONTROL
- ? ;
\ 2 i A2 : Informes de
INICIO =—> PLANIFICACION CIERRE cierre del
g E E 1 proyecto
i 4 J; H fEtapalll§ n o
. Etapal g \ 4 . R ProjectLibre
» IMPLEMENTACION
Programacion R BEEl
ProjectLibre”

Figura 4.
Intervencion de ProjectLibre en los grupos de procesos y las etapas de un proyecto

ProjectLibre resulta especialmente util para la optimizacion de proyectos en
términos de tiempo-coste durante su programacion, puesto que facilita la admi-
nistracion eficaz de los recursos a través de un proceso optimizado de asignacion y
nivelacion de los mismos. La correcta asignacion y nivelacion de recursos permite
maximizar la eficacia y provecho de los recursos, respetando el requisito de que en
ninguno de los periodos de tiempo en los que este se ejecuta, el consumo de algun
recurso supere a las disponibilidades existentes.

Para llevar a cabo la programacion de un proyecto, ProjectLibre requiere la
introduccion de cinco conjuntos de datos principales, que se interrelacionan entre
ellos. Estos son:
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e [nformacion general del proyecto (nombre del proyecto, duraciéon de la jor-
nada laboral, duracion de la semana laboral, fecha de inicio del proyecto,
etc.).

¢ Informacion relativa a las fareas y las dependencias entre las mismas (tipo,
requisitos o restricciones, duracion prevista, etc.).

¢ Informacion relativa a los recursos (tipo, disponibilidad, costo unitario aso-
ciado, etc.).

e Calendarios sobre los que realizar la programacion de las tareas, asi como
aquellos especificos asociados a algin recurso o tarea concreta, si es
oportuno.

¢ Informacion relativa a los requisitos aplicables durante el proceso de asig-
nacion de recursos a tareas.

Para facilitar la introduccion de esta informacion, ProjectLibre ofrece tablas de
introduccion de datos diferenciadas donde introducir de manera intuitiva cada uno
de los conjuntos de datos demandados.

La interfaz gréfica de ProjectLibre permite visualizar la informacion a través
de graficos que facilitan la interpretacion del desarrollo del proyecto en su conjun-
to, como son el diagrama de Gantt, que permite identificar el camino critico, y el
diagrama de red perT. Adicionalmente, permite visualizar parametros especificos,
como son las modificaciones sobre los calendarios, las variaciones en la duracion
real de las tareas o las sobreasignaciones de recursos devenidas mediante histogra-
mas de recursos, entre otros. Estas funcionalidades son especialmente utiles en las
etapas de seguimiento y control del proyecto.

Finalmente, ProjectLibre permite la presentacion de resultados y la descarga de
datos del proyecto a otros programas u hojas de calculo, con el fin de facilitar la
elaboracion de informes y personalizar graficos para el analisis de la evolucion y
los resultados finales alcanzados. Esta funcionalidad es especialmente util para la
elaboracion de informes finales de cierre del proyecto.
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2. Vision general
de ProjectLibre™

2.1. Terminologia

Antes de comenzar con la exposicion de las funcionalidades del programa, convi-
ene tener presente el significado de ciertos términos relacionados con la gestion de
proyectos (Project Management) que iran surgiendo a lo largo del documento y su
correspondencia en inglés. Estos se presentan en la tabla 1.

Tabla 1. Terminologia empleada en ProjectLibre y la gestion de proyectos

Inglés Espaiiol Descripcion
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Resource
usage

Summary
task

Task

Task
Usage

View

WBS

Uso de
recursos

Tarea
resumen

Tarea

Uso de
tareas

Vista

EDT

Estructura de descomposicion del trabajo (Work

Breakdown Structure)

Por otro lado, en la tabla 2 se indican algunos comandos rapidos del teclado que
pueden resultar utiles para el manejo del programa.

Gestion de proyectos con ProjectLibre
ISBN: 978-84-18432-99-6

Tabla 2. Comandos rapidos del teclado en ProjectLibre

Comando Descripcion

CTRL +F, CTRL+ G o CTRL +L

CTRL +1

CTRL +C

CTRL +X

CTRL+V

CTRL+Z

™

16

Buscar
Insertar fila

Copiar objeto
seleccionado

Cortar objeto
seleccionado

Pegar objeto
copiado/cortado

Deshacer

Marta Braulio Gonzalo y Valeria Ibafiez Forés
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La simbologia utilizada en este manual indica lo siguiente:

Q Informacion o conclusion interesante
EY Ejemplo
A Informacion importante a considerar

Q Nota adicional o aclarativa

2.2. Instalacion
Para instalar la herramienta, se deben seguir los siguientes pasos:

Visitar la pagina web del desarrollador: https://www.projectlibre.com/.
Descargar la ultima version y ejecutar el fichero.

Seguir las instrucciones de instalacion del mend.

Aceptar términos y condiciones.

Opcionalmente, introducir la direccion de correo electronico del usuario
para recibir noticias y actualizaciones.

M NS S

La herramienta se instala en el idioma que tiene configurado por defecto el equipo.

2.3. Entorno de trabajo

La interfaz principal de ProjectLibre es la que se muestra en la figura 5.

MENUS: TAREA, RECURSO, VISTA I

L ProjectLibre. § =

TR
=

e Jfsvess

I SUB-VISTAS m?ﬁ”idﬂjl o
HERRAMIENTAS

wos ome. ouration v predecessors Resource g

[————1  ATRIBUTOS O CAMPOS

NUMERACION DE LAS FILAS

TABLA DE TAREAS O RECURSOS

Figura 5.
Entorno de trabajo de ProjectLibre
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e Parte superior: barra de menus (File, Task, Resources y View), barra de
herramientas para cada uno de los ments en los que se puede navegar y
subvistas.

e Parte principal:

— Panel izquierdo: tablas de tareas o recursos (segun el menu activo), co-
lumnas de atributos o campos y primera columna con la numeracion de
filas.

— Panel derecho: area del grdfico Gantt con su escala temporal. La esca-
la temporal se puede ampliar o reducir realizando zoom desde el menu
Vista.

2.4. Vistas

ProjectLibre ofrece diversas opciones de visualizacion, cada una de las cuales
resulta util segln las necesidades de la usuaria en cada momento. Se accede a tra-
vés del menu View ubicado en la parte superior de la interfaz principal, seglin se
muestra en la figura 6.

P———N\E N ) High-end Lawn Furni... +
Projectlibre. ) - =
Fle  Task  Resource View EZEN] ] (7}
Network [=] Projects || [ Histogram  [£3 Resource Usage || No Filter v
wes e || [l Report || (23 Charts []No sub window | No Sorting -
Gantt BB TeskUsage || Resources %24 Task Usage Mo Group -
Tack views Resource views Other viens Sub-views Fiters

Figura 6.
Menu View

Las vistas mas utiles que ProjectLibre ofrece son las siguientes:

e Gantt: permite la vista combinada de la Tabla de tareas (panel izquierdo) y
del diagrama de Gantt (panel derecho), de forma que cada barra del diagra-
ma corresponde con la temporalizacion de cada tarea (de inicio a fin).

e Network: diagrama de red PERT que representa las tareas mediante etiquetas
que contienen la duracion y las fechas de inicio y fin y las dependencias entre
tareas. Resulta atil para visualizar las tareas del proyecto en forma de diagrama
de flujo. Ademas, la propia vista del diagrama permite realizar cambios, como
son el desplazar las etiquetas de las tareas y modificar vinculos y/o texto.

e J/BS: muestra las tareas mediante un diagrama de flujo jerarquizado.

e Task Usage: muestra la distribucion horaria del trabajo asociado a cada ta-
rea, plasmada en el calendario. Permite hacer modificaciones del numero de
horas de trabajo diario asociado a cada tarea.

e Resources Table: contiene la lista de recursos y sus atributos (en los campos
de las columnas).

e RBS: muestra los recursos mediante un diagrama de flujo jerarquizado.
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e Resource Usage: muestra la distribucion horaria del trabajo asociado a cada
recurso, plasmada en el calendario. Permite hacer modificaciones del nime-
ro de horas asignadas a cada recurso.

e Zoom: desde el menu Task, se puede hacer zoom in / zoom out para ver el
calendario con mayor nivel de detalle. El nivel mas detallado posible es cada
dos horas.

e Sub-views: permite dividir horizontalmente la pantalla en dos secciones con
el fin de ofrecer una vista combinada que resulta muy util para visualizar
diferente tipo de informacion al mismo tiempo. Se accede, o bien desde la
propia seccion dentro del menu View, o bien desde los botones ubicados en
la parte superior derecha de la interfaz (tal y como se observa en las figuras
5y 6). Las sub-views se abordan mas adelante.
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3. COmo crear un nuevo
proyecto

Al iniciar el programa, este da la opcidén de crear un nuevo proyecto (Create
Project) o abrir uno existente (Open Project). Al crear un nuevo proyecto, el pro-
grama solicita el nombre del proyecto, el nombre de la persona que gestiona el
proyecto (Project Manager) y la fecha de inicio (Start Date), ademas de permitir
introducir anotaciones (Nofes).

La casilla Forward scheduled tiene como objeto programar el proyecto desde
la fecha de finalizacion, de manera que, cuando se activa la casilla, se solicita la
fecha fin del proyecto (Finish Date), en lugar de la de inicio.

Una vez aceptadas las opciones introducidas, el programa muestra su interfaz
principal, descrita en la figura 5.

3.1. Informacion del proyecto

El primer paso es acceder a la informacién del proyecto (Project Information)
desde el ment File y revisar las opciones (véase figura 7).

Los campos Name, Manager, Start/Finish ya se han cumplimentado anterior-
mente al crear el proyecto. Por tanto, se introduce ahora la siguiente informacion:

e Current Date: fecha actual.

e Status Date: fecha de estado en la que se desea controlar el seguimiento del
proyecto. Aparece reflejada en el diagrama de Gantt mediante una linea ver-
tical a trazo discontinuo de color verde.

e Base Calendar: calendario base. Por defecto se muestran los tres tipos
(Standard, 24 hours y Night Shift) aunque se pueden crear nuevos calenda-
rios, como se ve mas adelante.

e Project Status: estado en el que se encuentra el proyecto (planning, pending
approval, active, completed, cancelled, on hold).

Cabe sefialar que esta informacion puede modificarse en cualquier momento,
ahora bien, si se modifica una vez iniciada la programacion, la temporalidad de las
tareas puede verse alterada.
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Por otro lado, en la pestafia Statistics del ment se muestran las estadisticas del
proyecto en términos totales de duracion, trabajo y coste. En la pestana Notes pue-
den incluirse comentarios o notas aclaratorias sobre el proyecto.

La fecha de inicio del proyecto aparece reflejada en el diagrama de Gantt
mediante una linea vertical negra a trazo discontinuo y la fecha de estado,
mediante una linea vertical verde a trazo discontinuo.

% Project Information X

Statistics MNotes

Mame: High-end Lawn Furniture

Manager: Patty-0 Furniture
fart: 04/03/1308:00 <)) CurrentDate: -
Finish: 28/03/13 17:00 ~ | StatusDate: [14/03/13 -
Forward scheduled ase Calendar: | Standard D
Priority: 500 - Project Status: | Planning v
Project Type: Other ~ Expense Type: |Mone ~
Division: Group:
Met Present Value: 0 Benefit: 0%
Risk: 0.0
Close Help
&5 Project Information s

General Statistics Notes

Mame: |High-end Lawn Furniture

Start: 04/03/13 08:00 Finish: 28/03/13 17:00
Baseline Start: Baseline Finish:

Actual Start: Actual Finish:

Duration: 19 days Baseline Duration: 0 days

Actual Duration: 0 days Remaining Duration: 12 days

Work: 280 hours Baseline Work: 0 hours

Actual Work: 0 hours Remaining Work: 280 hours
Cost: € 508,00 Baseline Cost: €0,00

Actual Cost: €0,00 Remaining Cost: € 508,00

Help

Figura 7.
Menu Informacion del Proyecto: General (arriba) y Estadisticas (abajo)
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3.2. Guardar el proyecto

Los proyectos creados en ProjectLibre pueden guardarse en dos formatos
diferentes:

e *pod: es el formato por defecto de los ficheros creados en ProjectLibre.
e *xml: permite el intercambio de ficheros con el programa comercial
Microsoft Project.

El guardado del proyecto se realiza desde el boton Save, dentro del menu File.
El botén Save as permite modificar el nombre del proyecto y guardarlo en otro
formato de archivo.
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4. Tareas

Las tareas o actividades son las acciones necesarias para elaborar los entregables
del proyecto. Existen cuatro tipos de tareas:

e Tarea normal (7ask)

e Hito (Milestone)

e Tarea resumen (Summary task)
e Repetitiva

En las siguientes secciones se describe como introducir cada tipo de tarea en
el programa y, previamente, se presenta el formato de visualizacioén de la Tabla de
tareas.

4.1. Tabla de tareas

La Tabla de tareas se visualiza desde el ment Task > Gantt (véase figura 8). Las
columnas basicas que se visualizan por defecto son Information, Name, Duration,
Start, Finish, Predecessors, Resource Names. La disposicion de estas columnas
puede modificarse, bien cambiando el orden de las mismas y/o insertando u ocul-
tando columnas:

e Cambiar el orden: clic sobre el titulo de la columna y arrastrar con el raton
hasta la posicion deseada.

e Insertar columna: clic con botén derecho del raton sobre el titulo de la co-
lumna a la izquierda de la cual se quiere insertar la nueva y pulsar Insert
column. En el menu desplegable que aparece se elige el campo deseado.

e Ocultar columna: clic con boton derecho del raton sobre el titulo de la co-
lumna a ocultar y pulsar Hide column.

e Buscar valor en columna: clic con boton derecho del raton sobre el titulo de
la columna y pulsar Find. Introducir el texto o valor a buscar.

e Personalizar columna: los campos que finalizan con un digito en su nombre
(por ejemplo: Costl), pueden insertarse y renombrarse para crear un campo
personalizado.
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e Para introducir el contenido en la columna Name y, por ejemplo, copiar
texto desde otro documento, funcionan los comandos del teclado cTrL+C /
CTRL+V.

@ Las columnas no se crean ni se eliminan, sino que se muestran u ocultan.

| -,

g \R A
[ ProjectLibre. )

| File
= Network @ ZoomIn Copy || & Insert | j- Indent & Link 4 Information ﬂi: Assign Resources  #% Find
- WBS ©. Zoom Out I 4, Cut & Delete | 4 Outdent | ~_ Unlink | ™ Calendar Save Baseline “F Scroll To Task
Gantt X3 Task Usage Paste | Notes Clear Baseline Update
Views Clipboard Task

Task

Resource View

@ Name Duration Start Finish Pred s R Names

Figura 8.
Tabla de tareas

En cuanto a las filas, se pueden realizar las siguientes acciones:

e Borrar una fila existente: seleccionar toda una fila clicando sobre el nimero de
fila, hacer clic en el boton derecho del raton sobre la fila y pulsar @ pelete .

e Insertar una fila nueva: seleccionar toda una fila clicando en el nimero de
fila, hacer clic en el boton derecho del raton sobre la fila y pulsar = new . La
nueva fila se inserta arriba.

e Desplazar una fila de posicion:

1. Insertar una fila nueva.
2. Copy/Cut la fila a desplazar y Paste en la nueva fila en blanco insertada,

Copy

mediante los botones I .ot
Paste
Clipboard

3. Borrar la fila anterior (si se ha copiado y no cortado) con @ Delete

4.2. Tareas normales y su duracion

Una tarea o actividad es una accion necesaria para elaborar un entregable del
proyecto. Para introducir una tarea en ProjectLibre, se accede al menu 7ask y se
escribe el nombre de la tarea en la fila y campo correspondientes (columna Name).
Al introducir una tarea, se observa lo siguiente:
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e La duracion de la tarea (en el campo Duration) es, por defecto, de «1dia?».

e La tarea se situa, por defecto, en el dia de inicio del proyecto. La fecha se
puede modificar a conveniencia desde el campo Start.

e El campo Finish se calcula de forma automatica segiin la duracion de la
tarea.

¢ Enel diagrama de Gantt se grafia la barra asociada a dicha tarea, acotada por
las fechas de inicio y fin.

Una vez creada la tarea, esta se puede ver, modificar e introducir nueva infor-
macion en el didlogo Task Information, al que se puede acceder de dos modos dife-
rentes: al hacer doble clic sobre el nombre de la tarea, o bien, con el cursor sobre la
tarea, al hacer clic en el icono Information, tal y como se muestra en la figura 9.

[ T - N
— B« - |
s . . LT
ProjectLibre. )
—— File Task Resource View
= Network @, ZoomIn Copy || & Insert | j Indent & Link 2 /- Information ﬁ-’,: Assign Resources  #% Find
WBS #, Zoom Out l g o Cut & Delete | ~4 Outdent | -2 UnlinK ™" Calendar Save Baseline "t Scroll To Task
Gantt | X Task Usage Paste T | Notes Clear Baseline Update
Views Clipboard Task
@ Name 1. clic Work Duration Start Finish Predecessors
1 8 hours 1day? 04/03/13 08:00 04/03/13 17:00
X Analyse requirements 24 hours 3 days? 05/03/13 08:00 07/03/13 17:00 1
3 Develop project 160 hours 10 days? 08/03/13 08:00 21/03f13 17:00 2

Figura 9.
Acceso al menu Task Information

Al acceder al menu, se puede introducir la informacion mostrada en la figura 10.

i

% Task Information - 1 X

General Predecessors Successors Resources Advanced Notes

Mame: |Sign agreement

Duration: 1 day? Estimated
Percent Complete: 0% 5 Priority: 5005
Cost: € 215,00 Waork: & hours
Dates
Start: 04/03/13 08:00 -/ Finish: 04/03/13 17:00 -
Baseline Start: Baseline Finish:

Figura 10.

Menu Task Information
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Dicha informacién comprende, principalmente:

e Duracion de la tarea. Cuando se desconoce exactamente la duracion de la
misma, se activa la casilla Estimated (estimada), de manera que junto al va-
lor en el campo duracion, se mostrard un interrogante (ejemplo: 1dia?).

e Porcentaje completado (Percent Complete): para introducir el progreso de
la tarea.

e Trabajo (Work): horas de trabajo que implica la tarea.

¢ Inicio (Start): fecha y hora en la que se inicia.

e Fin (Finish): fecha y hora en la que finaliza.

En cuanto a la duracion de la tarea, esta puede expresarse en las unidades mos-
tradas en la tabla 3:

Tabla 3. Codigos para las unidades temporales de duracion

Cddigo a teclear Unidad horaria

m minutos

h horas

d dias

w semanas

month mes

ed dias transcurridos (elapsed days)
eh horas transcurridas (elapsed hours)
? (sufijo) duracion estimada

Q Independientemente de la unidad que se introduzca en el campo Duration, el
programa ProjectLibre convierte la duracion y la expresa en dias.

La tarea «Preparacion de mortero de cemento» tiene una duracion de 1 hora.
Y, Cuando se introduce en el campo correspondiente a la duracién «1h», el
: resultado que devuelve el programa es «0,125 days», ya que:
Ej. 1 1 hora- 1 dia/ 8 horas de trabajo = 0,125 dias
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@ was Name Work Duration Start Finish

[0 b, 20 [27 dabr. 20 4 de i 20 lidemagzo  |igde
bbb bbb bbb bbb bbb bbbbbhhlh

] Adquisicién resistencia hormigdn a los 7 dias (MAL) 168 hours| 21 days 20/04/20 16:00 | 19/05/20 16:00

4.3. Hitos

Un hito es un momento en el tiempo que indica un evento relevante de un
proyecto y se usa para supervisar su progreso (por ejemplo: un resultado, una
meta, un entregable, etc.). Un hito se introduce como una tarea mas, y basta con
asignar a la tarea una duracion de 0 (aunque no necesariamente un hito tiene que
tener una duracion de 0).

ProjectLibre utiliza un pequefio rombo ¢ como simbolo para representar los
hitos en el diagrama de Gantt. Todas las tareas con una duracion 0 se muestran
como hito automaticamente, aunque también se pueden marcar como hito otras
tareas con cualquier duracion.

Para introducir un hito, se puede proceder de dos formas diferentes:

e Hito con duracion 0 dias: basta con crear una tarea y asignarle una duracioén
de 0 dias.

e Hito con duracién mayor de 0: crear una tarea con su duracion y acceder al
menu Task Information (véase figura 12) y, en la pestafia Advanced, marcar
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la tarea como hito (Display task as milestone). En este caso, el simbolo ¢ en
el Gantt se sitia en la fecha de inicio de la tarea.

i

S Task Information - 2 X

General Predecessors Successors Resources Advanced  Notes

Mame: |Concesion licenda de obras

WBS: Display task as milestons *
Constraints

Constraint Type: As Soon As Possible w | Constraint Date: -
Deadline: -

Type: Fixed Units v Effort Driven

Task Calendar: w [] Ignore Resource Calendar

Earned Value Method: | % Complete v

Figura 12.
Mostrar una tarea como hito

4.4. Tareas resumen

Una tarea resumen es una tarea que agrupa a otras subtareas y que, por tanto,
tiene una jerarquia mayor. Sirve para esquematizar el listado de tareas y facilitar
la visualizacion, especialmente cuando el listado es muy extenso. Generalmente,
las tareas resumen se corresponden con las principales fases de un proyecto. Por
ejemplo, en una obra de construccion, las tareas resumen podrian corresponder a
los capitulos de obra: movimiento de tierras, cimentacion, estructura, albafileria,
instalaciones, etc.

Para organizar la estructura de tareas se emplean los botones /ndent/Outdent,
que se encuentran en el menu 7ask (véase figura 13). Estos funcionan como una
sangria de un procesador de textos.

—

_ o
{ ProjectLibre. ) "

File | Task ‘ Resource View
— [ Network @ ZoomIn Copy || o Insert |fi Indent
WBS B, Zoom Out | . . Cut || == Delete |\" 4 Outden
Gantt |5 Task Usage Paste
| Views I Clipboard I
Figura 13.

Botones para jerarquizar tareas
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Seleccionando la tarea y pulsando el boton correspondiente, se puede subir
(Outdent) o bajar (Indent) la tarea en un nivel. La tarea superior quedara consti-
tuida como una tarea resumen. En el grafico Gantt, las tareas resumen cambian su
grafismo y se muestran como una llave de color negra que agrupa a las subtareas.
La figura 14 muestra un ejemplo.

N 26 doct, 20 2 de nov. 20 9 de nov. 20 16 de nov. 20 2
b bbb bbbbbblbbbbbbbhbbblbbbbhbhbl
ElMovimiento de tierras . ]

Y] Name

=0

Desbroce v impieza del terreno

Excavacidn de zapatas

Fin de movimiento de tierras

ElCimentacion

Encofrado de zapatas

Hormigdn de limpieza

Colocacidn de separadores sobre el hormigdn de limpieza

Hormigonado

Fraguado hormigdn (tiempo transcurrido)
(%] Fin de cimentacién

1911

Figura 14.
Ejemplo de jerarquizacion de tareas y subtareas

Mostrar la EpT (WBs) puede resultar interesante para generar una numeracion

Q del listado de tareas. Sin embargo, ProjectLibre no realiza esta accion de
forma automatica. Para mostrar la EDT se tiene que insertar dicha columna
en la Tabla de tareas e introducir manualmente los codigos deseados en los
campos, como se muestra en la figura 15 a modo de ejemplo.

que ProjectLibre la calcula automaticamente en funcion de las subtareas que
engloba.

@ La duracion de las tareas resumen no debe modificarse manualmente, puesto

@ o WBS Name
1 1 1 = Movimiento de tierras
2 EX 1.1 Desbroce y limpieza del terreno
3 3 1.2 Excavacidn de zapatas
4 4 2 El Cimentacidn
5 5 2.1 Encofrado de zapatas
2 Hormigdn de [ 2.2 Hormigédn de limpieza
7 Colocacidn de separadores z0Dre & normigon de Impieza 7 23 Colocacién de separadores sobre el hormigén de lmpieza
L] *
Figura 15.
Ejemplo de EpT (wBS)
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Una vez organizadas las tareas, se observa que las tareas resumen tienen a su
izquierda un signo +/-, sobre el que se puede clicar para mostrar u ocultar las ta-
reas que engloba. También se puede hacer seleccionando la tarea (clicando en la
numeracion de toda la fila), haciendo clic en el boton derecho del raton y clicando

en los botones " Expand
4 Collapse

Conviene crear la tarea resumen del proyecto para visualizar de forma rapida

@ en la primera fila del listado de tareas las generalidades del proyecto. Para
ello, simplemente se crea una primera tarea con el nombre del proyecto y se
sangran el resto de tareas: seleccionando todas las filas a la vez y clicando en
Indent. Véase figura 16.

M  wes Name
EIPROYECTO NAVE INDUSTRIAL

Permisos

1

2 1

3 BEEFR2 Firma del Acta de Replanteo
4 3 Reuniones de la D.F.

5 4 ElMovimiento de tierras

[ 4,

1

Desbroce y limpieza del terreno

Figura 16.
Tarea resumen del proyecto

4.5. Tareas repetitivas o periodicas

Una tarea repetitiva es una tarea que se repite periodicamente en el tiempo. Sin em-
bargo, ProjectLibre no incorpora la opcion de crear tareas repetitivas o periodicas de
forma automatica. Para ello, se deben crear manualmente todas las tareas individuales
que deban repetirse de manera periodica, cada una en su correspondiente fecha y, a
posteriori, crear una tarea resumen de orden superior que las englobe a todas.

4.6. Restricciones temporales de tareas

ProjectLibre permite asignar restricciones temporales a las tareas (Constraints). Para
ello, debe accederse al menu Task Information y a la pestafia Advanced (figura 17).

% Task Information - 3 X

General Predecessors Successors Resources Advanced  Notes

Mame: |Excavacion de zapatas

WBS: 1.2 [] Display task as milestone
Constraints
Constraint Type: Start Mo Earlier Than -~ | Constraint Date: 31/03/20 07:00 -
Deadline: -
Figura 17.

Restricciones de las tareas (Constraints)
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Existen dos restricciones:

e Constraint Type y Constraint Date (tipo de restriccion): ProjectLibre define
ocho tipos de restricciones temporales para condicionar las fechas de inicio
y/o finalizacion de las tareas (véase tabla 4). Se debe introducir el tipo de
restriccion y también la fecha que condicionara la misma. ProjectLibre per-
mite la introduccion de un Unico tipo de restriccion para cada tarea.

Tabla 4. Tipos de restricciones temporales de las tareas

Restriccion _ Descripcion

As soon as
possible

As late as
posible

Must start
on

Must finish
on

Start no
earlier tan

Start no
later than

Finish no
earlier than

Finish no
later than

Lo maés pronto
posible

Lo mas tarde
posible

Debe
comenzar el

Debe finalizar
el

Iniciar no
antes de

Iniciar no mas
tarde de

Finalizar no
antes de

Finalizar no
mas tarde de

La tarea se inicia tan pronto como las tareas
predecesoras lo permitan. Esta opcion esta
habilitada por defecto al planificar el proyecto
desde la fecha de inicio (forward scheduled).

La tarea se inicia lo mas tarde que las tareas
predecesoras lo permitan. Esta opcion esta
habilitada por defecto al planificar el proyecto
desde la fecha de finalizacion.

La tarea se debe iniciar en una determinada fecha,
anulando las tareas predecesoras.

La tarea debe finalizar en una determinada fecha,
anulando las tareas predecesoras.

La tarea no puede iniciarse antes de una
determinada fecha.

La tarea no puede iniciarse mas tarde de una
determinada fecha.

La tarea no puede finalizar antes de una
determinada fecha.

La tarea no puede finalizar después de
determinada fecha.

e Deadline (fecha limite): fecha en la que deberia terminar la tarea, reflejada
en el Gantt con un simbolo ¢ en color amarillo. Cuando la fecha fin plani-
ficada supera dicho deadline, aparece un icono de aviso @ en la columna
Information de la Tabla de tareas.
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4.7. Vincular tareas

Las tareas de los proyectos deben llevarse a cabo en un determinado orden que
debe especificarse a través del establecimiento de vinculos o dependencias entre
ellas. Existen diversos tipos de dependencias que determinan el inicio de una tarea
en base al inicio o el final de otra.

En una relacion de dependencia entre dos tareas, la primera tarea se conoce
como predecesora y es la tarea independiente (A), mientras que la segunda se de-
nomina tarea sucesora y es la dependiente (B). Ambas se relacionan mediante una
flecha, de manera que la punta de la flecha recae sobre la tarea dependiente (véase
figura 18).

. A — B

Figura 18.
Relacion de dependencia entre dos tareas

Las relaciones de dependencia entre tareas son cuatro (figura 18):

Tabla 5. Tipos de relacion de dependencia entre dos tareas

Tipo de dependencia Grafico Descripcion
FS (Finish-Start, Fin- a2 =, ,  Bnopuede comenzar hasta que A
Comienzo) haya finalizado
SS (Start-Start, Ef B no puede comenzar hasta que A
Comienzo-Comienzo) e haya comenzado
FF (Finish-Finish, Fin- f:l B no puede finalizar hasta que A haya
Fin) . finalizado

SF (Start -Finish, [ .+ 2 Bnopuede finalizar hasta que A haya

Comienzo-Fin) comenzado

lag (1apso) A, Periodo de tiempo de retraso o
adelanto aplicable a cualquier tipo de
vinculo

Hay varias formas de vincular tareas en ProjectLibre:
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e Desde la Tabla de tareas: hacer clic sobre las tareas (dos o mas) a vincular
(con tecla Control activa) y pulsar botoén Link en el ment Task (véase figura
19). Se asignard por defecto el tipo FS.

P— [« - )
{ ProjectLibre. ) .
= File ‘ Task ‘ Resource View
Metwork @ Zoom In Copy || o Insert | b Indent & Link # Information
E WES @, Zoom Qut r . Cut &= Delete | 4 Outdent [\ _ Unlinkf| *“** Calendar
Gantt |55 Task Usage Paste T | Motes
Views || Clipboard || Task
® e . 423 de marg 20 30 de mar
plolblblbblbloipk
1 1 B Movimiento de tierras P
B 1.1 Desbroce vy limpieza del terreno
3 1.2 Excavacion de zapatas
4 Fin de movimiento de tierras
5 2 B Cimentacién
6 2.1 Encofrado de zapatas
7 2.2 Hormigdn de limpieza
8 2.3 Colocacidn de separadores sobre el harmigdn de limpieza
9 2.4 Hormigonado

Figura 19.
Botones para vincular tareas

e Desde el Gantt: hacer clic en la barra de la tarea independiente (A) y
arrastrar el cursor hasta la tarea dependiente (B). Al soltar el cursor las
tareas quedan vinculadas, por defecto, con una relacioén FS, la cual se
puede modificar posteriormente haciendo clic sobre la flecha y cambian-
do el tipo de dependencia desde el menu desplegable que emerge (7ask
Dependency).

e Desde la columna Predecessors en Tabla de tareas: introducir manual-
mente los cédigos de las vinculaciones (FS, SS, etc. mostrados en la
tabla 5).

Una vez generada la vinculacion, esta se puede modificar mediante diferentes
procedimientos:

e Con doble clic sobre la tarea, desde el ment Task Information y en la pestafia
Predecesoras, como se observa en la figura 20.

e Directamente con doble clic sobre el campo Predecessors.

e Desde el Gantt, clicando en la flecha del vinculo.

Gestion de proyectos con ProjectLibre™ 35 Marta Braulio Gonzalo y Valeria Ibafiez Forés
ISBN: 978-84-18432-99-6 DOI: http://dx.doi.org/10.6035/Sapiential 80



& Task Information - 5

General Predecessors Successors Resources Advanced Notes

Name: Desbroce y limpieza del terreno

Predecessors:

Predecessor Predecessor ID Type Lag
Firma del Acta de Replanteo 2|Fs v 0days
FF
SF
SS
Figura 20.

Menu Task Information y pestaiia Predecessors

Para desvincular tareas, simplemente, se seleccionan y se pulsa el boton Unlink
o bien, desde el menu Task Dependency se pulsa Remove.

Sise desea introducir una demora o adelanto, se accede al ment Task Dependency
y se introduce en la casilla Lag el tiempo precedido de un signo —/+, en funcion de
si se trata de un adelanto o retraso, respectivamente.

Si se desea que la tarea B comience 1 dia antes de que A termine, se debe

E introducir el siguiente codigo en la columna Predecesoras: 10FS-1day, como
. se muestra en la figura siguiente. El nimero 10, en este caso, hace referencia
Ej. 3 ;
al nimero de fila de la tarea A predecesora.

A
B 10F5-1 day

Figura 21.
Ejemplo 3: codificacion de tareas predecesoras

4.8. Visualizacion de tareas en Gantt

A medida que se introducen tareas, se grafia una barra para cada una de ellas
que representa su distribucion temporal. De esta manera, se va generando el dia-
grama de Gantt de forma progresiva. Dicho diagrama se visualiza desde el menu
View > Gantt. La figura 22 muestra un ejemplo de visualizacion de la Vista Gantt,

que incluye el diagrama.
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=

_— \F & )
[ ProjectLibre. o s

| File Task Resource View
T MNetwork RES [=] Projects || [t Histogram  [E§ Resource Usage || No Filter v
B WES [E4 Resource Usage Report || [ Charts [ o sub window ||| No Sorting o
Gantt | % Task Usage || mesources [EZ Task Usage No Group w
Task views Resource views Other views Sub-views Filters
. 423 de marg 20 30 de marg 20 6 d'abr. 20 13 d'abr.
O wes tame Cost Duration () [g bbbl \D—[[g bbbbbbbhbbblbbhl
1 1 ElMovimiento de tierras € 0,00(11,875 days?/26/03/1 ]
2 L1 Desbroce v limpieza del terrer £0,00 11,875 days? 26/03/20 e s s
i B 1z Excavacion de zapatas €0,00 2,5 days?|31/03/20
4 1.3 Fin de movimiento de tierras €0,00 0 days 02/04/20
5 2 ElCimentacién €0,000 7,75 days?02/04/1
[ 2.1 Encofrado de zapatas €0,00 1,5 days? 02/04/20
7 2.2 Hormigdn de limpieza €0,00 1day?|06/04/20
8 2.3 Colocacidn de separadores so €0,00 0,25 days 07/04/20
9 2.4 Hormigonado €0,00 2 days |07/04/20
10 @ 2.5 Fraguado hormigdn (tiempo tr €0,00 3 days 09/04/20
Figura 22.

Vista Gantt

Existen diversas opciones de visualizacion del diagrama, tal y como se describe
a continuacion:

e (Codigo de colores: las tareas no criticas se muestran en color azul, mientras
que las tareas criticas, en rojo.

o Las tareas resumen se convierten en una llave de color negro que engloba a
sus subtareas.

e Los hitos se muestran con el simbolo ¢, en color negro.

e Las fechas limite (deadlines) se muestran con el simbolo ¢, en color
amarillo.

e La holgura total (7otal slack) se representa con una trama azul.

e Lafecha de inicio del proyecto (introducida en el menu Project Information)
se visualiza mediante una linea vertical negra de trazo discontinuo.

o Lafecha de estado del proyecto (introducida en el menu Project Information)
se visualiza mediante una linea vertical verde de trazo discontinuo.

e En la primera columna de Informacion aparecen simbolos que alertan de
determinados aspectos. Al pasar el cursor por encima de los simbolos, se
muestra un mensaje informativo.

e Didlogo clic derecho: haciendo clic en el 4rea del Gantt con el botén de-
recho se accede a un didlogo con diferentes opciones de visualizacion (fi-
gura 23). Estas son las siguientes: mostrar asignaciones de recursos (Show
Assignments, serd muy util para la introduccion de los recursos), mostrar
dependencias (Show Links), mostrar el calendario (Show Calendar), mostrar
las filas (Show Rows), estilos de barras (Bar Styles, para milestones, deadli-
nes, critical tasks, etc.) y estilos de anotacion (Annotation Styles).
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y 02/04
"
E

Right click for options

Split
Show Assignments
®  Show Links
®  Show Calendar
Show Rows
Bar Styles >
Annotation Styles >

Figura 23.
Dialogo sobre opciones de visualizacion del Gantt

Q La primera opcion del didlogo (Splif) permite dividir tareas, mostrando un
tiempo de interrupcion intermedio. El cursor toma la forma ||— y basta con
hacer clic sobre la barra de la tarea para dividirla. Posteriormente se pueden
modificar los tiempos de inicio y fin arrastrando con el cursor. Véase como
ejemplo la tarea 1.1 en la figura 22.

4.9. Camino critico y holguras

En un proyecto existen ciertas tareas que permiten cierto retraso sin que afec-
ten a la fecha de finalizacion del proyecto. Por otro lado, existen tareas que no
pueden retrasarse sin que la fecha de finalizacion se vea afectada. Estas tltimas se
denominan tareas criticas (Critical Tasks), las cuales conforman el camino critico
(Critical Path) del proyecto.

ProjectLibre calcula automaticamente el camino critico, mostrando en color
rojo las barras del Gantt que lo constituyen.

Para asegurarnos de que el camino critico se esta mostrando, se debe activar
la opcién Critical Tasks en el didlogo de la figura 24 (pinchando sobre el boton
derecho del raton en la region del Gantt).
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ARND

ProjectLibre. )
File Task Resource View
4t Open © Close || %= Print /. Information Save Baseline
O New O Preview ** Calendar Clear Baseline
save M saveas > PDF Projects i ProjectsDialog Update
File Print Project
4 2, . .
23 de marc 20 30 de marg 20 6 d'abr. 20 13 d'abr. ¢
WBS Name
® pbhbbbhbhbhbhbhbbbbhbhbbhblbbbbbbbl
1 1 EMovimiento de tierras L . 2
2 1.1 Desbroce y limpieza del terreno i split L S
3 @ 1.2 Excavacién de zapatas S
4 1.3 Fin de movimiento de tierras ow Assignments 2/04
5 2 [ Cimentacion ® Show Links 3
6 2.1 Encofrado de zapatas ®  Show Calendar
7 2.2 Hormigon de limpieza Show Rows E‘.L
8 2.3 Colocacién de separadores sobre el hormigon de limpieza Bar Styles 408Y Noncritical Tasks
g 24 Hormigonado Annotation Styles 3. Critical Tasks
0 @ 25 Fraguado hormigdn (tiempo transcurrido) —_—
| i : ®  Summary Tasks
Figura 24.

Mostrar las tareas criticas

Por otro lado, cabe introducir los conceptos de holgura total y holgura libre, que
se definen a continuacion:

e La holgura total (Total Slack), H, son las unidades de tiempo que puede re-
trasarse una tarea sin que aumente la duracion total del proyecto. Si es cero,
la tarea es critica. La opcion para mostrar la H, en el Gantt se encuentra al
final del dialogo mostrado en la figura 24.

La H, de una tarea A se calcula como TMTT, — TMPT,, donde:

TMTT,: tiempo mas tarde de terminacion de la tarea A.
TMPT,: tiempo mas pronto de terminacion de la tarea A.

e Laholgura libre (Free Slack), H , son las unidades de tiempo suplementario
para ejecutar dicha tarea sin que afecte a la duracion total del proyecto ni al
inicio de las tareas sucesoras. ProjectLibre no muestra la H, en el Gantt.

La H;, se calcula como TMPC - TMPT,, donde:

TMPC,: tiempo mas pronto de comienzo de la tarea B.
TMPT,: tiempo mas pronto de terminacion de la tarea A.

La figura 25 describe graficamente la H_ y la H , asi como la relacion entre
ambas.
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A | A
Te ) Te )

Tiemp¢ disponible para ejecutar A

H; -
H, -
B ] . B |
o Te B) PY o Te B PY
| TMP/(;‘ | TMP:B\—‘ ’_'Ij/IITCB ’_'I'/I\’/ITTB

Figura 25.
Holgura total y holgura libre

En el grafico Gantt, la H se muestra mediante una trama rayada de color azul, a
continuacion de o sobre la tarea, como se muestra en la tarea 1.1 de la figura 24. Se
puede afadir también la columna relativa al campo de holgura total (7otal Slack)
en la Tabla de tareas, siguiendo lo dispuesto en el apartado 4.1, para mostrar las
unidades de tiempo correspondientes.
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5. Temporalizacion
del proyecto

La temporalizacion de un proyecto es fundamental para realizar su programa-
cion. En ProjectLibre, la temporalizacion se programa a través del calendario
(Calendar), de manera que los datos introducidos en €l serviran de base para rea-
lizar los calculos temporales automaticamente. Por ello, es de vital importancia
comprender como ProjectLibre opera internamente.

El calendario del proyecto define los dias laborables, en los que si se desa-
rrollan tareas, y los no laborables, en los que el transcurso de las tareas queda
interrumpido o, lo que es lo mismo, el tiempo no computa a efectos de trabajo
planificado o ejecutado.

Cabe distinguir entre dos aspectos clave:

e Informacion temporal para el calculo de la duracion de las tareas y del pro-
yecto (Duration Settings). Es la informacion relativa a las horas/dia (jornada
laboral), horas/semana, dias/mes.

e Definicidn de calendarios (Calendar). Permite establecer qué dias son labo-
rables y no laborables y los horarios en los que se desarrolla la jornada de
trabajo. En base a ello, se distribuirdn las tareas y, por ende, se calculara su
duracion.

A continuacion, se detalla cada una de estas configuraciones.

5.1. Calculo de la duracion de las tareas y del proyecto

Para ajustar los célculos de la duracion, se accede al menu File, Calendar y
Options y se introduce la informacion que se muestra en la figura 26, la cual ser-
vira como base para que el programa realice los calculos.
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€ b= ®

For:
Standard v marg 2020 ahril 2020
O DDDODEDD ODDDDTUDD
(0 Use default 12 3 4 5 6 7 12 3 4
O Non-sorking time B vnsson o i B 7 & 81011
%2 Duration Settings 4 13 14 15 16 17 118
() Mon-default working
From: Tos These settings only apply to durations 20021 322324 35
Hours per day : = 27 28 29 30
Hours per week : | 4015
Days permonth : | 2015 juny 2020
O DDDUDD
oK Cancel Help 1 2 3 4 5 B

32 4 5 6 7 8 89 F8 910111213
10 11 1213 14 15 16 14 1516 17 18 19 20
17 1819 20 21 22 23 21 22 23 24 25 26 27
24 25 26 27 28 29 30 28 29 30

a1

New... 1! OK Cancel Help

Figura 26.
Configuracion de la duracion

5.2. Definicion de calendarios

El programa incorpora tres calendarios predefinidos, cuya configuracion se mu-
estra en la figura 27. Estos son:

e Standard: jornada laboral de lunes a viernes de 8:00-12:00 h y 13:00-17:00
h, sabados y domingos no laborables. Corresponde al calendario por defecto
del programa.

e 24 Hours: todos los dias son laborables durante las 24 horas.

e Night Shift (turno de noche): laborable de lunes a sébado en horario de 23:00-
3:00 hy 4:00-8:00 h.
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For:

(®) Use default

(C) Mon-working time

() Mon-default working time
From: To:

8:00 12:00

13:00 17:00

Standard v

mmarg 2020
DDDDDDD

ahril 2020
ODDDDDDOD

1234567
a[ 8]10 11 12 13 14
1516 17 18 18 20 2
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29 30 3

maig 2020
DDDDODDOD

1.2 3 4
5 67 8 910N
12 1314 15 16 17 18
19 20 21 22 23 24 25
26 27 28 29 30

juny 2020
DDDDDDD
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24 25 26 27 28 29 30
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12 3 4 5 8
T 8 910111213
14 1516 17 18 18 20
21 22 23 24 25 26 27
28 29 30

Far:

24 Hours ~

(®) Use default

() Non-working time

() Non-default working time
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0:00 0:00

marg 2020
DDDDDDD

abril 2020
DDDDDDD

1234567

g 8]10 11 12 13 14
1516 17 18 19 20 21
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maig 2020
DDDDDDD

12 3 4
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1213141516 17 18
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26 27 28 29 30

juny 2020
DDDDDDD
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345 8 7 88
10111213 14 15 16
171819 20 21 22 23
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N

For:

Night Shift v

marg 2020

abril 2020

(®) Use default

() Non-working time

(2) Non-default working time
From: To:

0:00 3:00
400 8:00

23:00 0:00

DDDDDDD

ODDDDDDD

12345667

8 ofiof11 1213 14
15 16 17 18 19 20 21
22 73 24 25 26 27 28
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maig 2020
DDDDDDD

12 3 4
5 6 7 68 810N
121314 1516 17 18
19 20 21 22 23 24 25
26 27 28 29 30

juny 2020
DDDDDDD
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3 4 56 7 8 49
1011 1213 14 15 16
17 1819 20 21 22 23

1.2 2 4 5 8
78 910111213
14 1516 17 18 19 20
21 22 23 24 35 26 27

1.2 3 4 456
78 810111213
141516 17 18 18 20
21 22 23 24 35 26 27
28 29 30

24 25 26 27 28 29 30
kil

28 29 30

Figura 27.
Calendarios Standard, 24 Hours, Night Shift de ProjectLibre

Como se observa en la figura 27, los dias laborables se muestran con fondo
blanco, mientras que los no laborables con fondo gris. Para ver el horario dia a
dia, basta con hacer clic sobre el dia del calendario. En el menu de la izquierda se
muestran las franjas horarias laborables.

Para crear un nuevo calendario, se deben seguir los siguientes pasos:

1. Clic en New en el menu (véase figura 26, parte inferior izquierda) y asignar
un nombre al calendario. Es recomendable hacer una copia de uno de los tres
existentes y realizar sobre €l las modificaciones oportunas para simplificar el
proceso.

2. Seleccionar los dias no laborables de la semana clicando en el encabezado
correspondiente (S, M, T, W, T, F, S) de un mes cualquiera de los mostrados
en el ment. También se pueden seleccionar varios dias simultaneamente,
manteniendo activa la techa crtL. Seleccionar la opcion Non-working time.

3. Seleccionar los dias laborables clicando en el encabezado correspondien-
te (S, M, T, W, T, F, §) de un mes cualquiera de los mostrados en el men.
También se pueden seleccionar varios dias simultaneamente, manteniendo
activa la techa crtL. Seleccionar la opcion Non-default working time. Asignar
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el horario de la jornada en el menu de la izquierda, teniendo en cuenta los
descansos (por ejemplo, almuerzo y comida).

4. Para indicar los dias festivos, clicar en el dia correspondiente sobre el calen-
dario y seleccionar Non-working time. Se puede buscar comodamente los
dias en el calendario mediante los botones # | » , situados en la
parte superior del mend. Pueden seleccionarse también varios dias simulta-
neamente manteniendo activa la techa crrL.

calendario deben coincidir con la configuracion de la duracion en Opciones
para que ProjectLibre calcule la duracion correctamente.

ﬂ iiImportante!! Las horas de trabajo de la jornada laboral definidas en el

5.3. Asignacion de calendarios
Los calendarios se pueden asignar a:

e El proyecto completo, accediendo al menu File, Project, Information
e indicando en el menu desplegable de Base Calendar el calendario
deseado.

e Las tareas, desde el menu Task Information, pestaiia Advanced, en Task
Calendar. Se puede, si se desea, clicar la opcidon de ignorar el calendario del
recurso.

e Los recursos, desde el meni Resource Information, en Base Calendar.
Ademés, se pueden hacer modificaciones puntuales sobre dicho calendario
y especificamente para dicho recurso, clicando en el icono de la derecha
&% . Por ejemplo, para introducir dias de vacaciones de un recurso en par-
ticular, sobre el calendario base que trabaja.
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#2 Task Information - 3 X

General Predecessors Successors Resources Advanced Notes

Name: Excavacion de zapatas

WBS: 1.2 [] Display task as milestone
Constraints
Constraint Type: StartNo Earlier Than | Constraint Date: 31/03/20 07:00 v
Deadline: v
Type: Fixed Units v Effort Driven
Task Calendar: v @gnore Resource Calendar
Earned Value Method:
Standard
24 Hours
INight Shift
= S = %= Change Working Calendar X
RBS Type
0
p—— ]
For:
General Costs Resource Availability Tasks Notes & Project Manager marg 2020 abril 2020
Based onCalendarioUTt DDDDDDD DDDDDDD
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Ell
Options... OK Cancel Help
F
Close Help
Figura 28.

Asignar un calendario a una tarea (izquierda) y a un recurso (derecha)

5.4. Consideraciones para el calculo de la duracion de las tareas

Conviene diferenciar entre dos aspectos fundamentales con los que ProjectLibre,
como cualquier sofiware de gestion de proyectos, trabaja:

o Trabajo (Work): es la cantidad de trabajo, en unidades de tiempo, necesaria
para llevar a cabo una determinada tarea. Para visualizar el trabajo asociado
a cada tarea, hay que insertar la columna Work en la Tabla de tareas.

Por ejemplo, para construir un muro de fabrica de ladrillo se requieren 10
IE horas de trabajo. Este trabajo puede ser desempenado por:

Ej. 4 * un solo operario A que invierte 10 horas o
* dos operarios, A y B, que invierten 5 horas cada uno. En total, el trabajo
necesario para ejecutar el muro sigue siendo de 10 horas.
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e Duracion (Duration): es el tiempo necesario para completar una tarea, te-
niendo en cuenta los recursos asignados. La duracién abarca desde el mo-
mento en que la tarea comienza al momento en que finaliza, sin incluir los
tiempos de descanso o dias no laborables. Por tanto, la duracion va ligada al
calendario y a las horas/dia de la jornada laboral.

o Tiempo transcurrido (Elapsed time): es el tiempo en dias naturales que tar-
da en completarse una tarea, es decir, incluyendo tiempos de descanso y
dias no laborables. Es decir, corresponde al paso de los dias del calendario.
Remitirse al Ej. 4.
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Como conclusion, ProjectLibre calcula la duracion de las tareas en base a tres
aspectos y en este preciso orden:

—_

. Trabajo necesario para desarrollar la tarea.

2. Opciones definidas en Duration Settings, es decir, las horas/dia de la jornada
laboral.

3. Calendario, en base al cual distribuye las horas de trabajo, dando como re-

sultado la duracion de la tarea.

5 Actd Duracion - Gi\La meva unitat\_UI\_DOCENCIA\DOCENCIA Proyectos | JAQ17 Direccié de Proj jectLibre\ TUTORIALVACtS Duracion.pod *

La barra de la tarea no se corresponde con una duracién de 1,25 dias porque la columna
Duration se mlrﬂln en base a Duration Settings.
N
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6. Recursos y costos

Los recursos son los medios necesarios para llevar a cabo un proyecto e incluyen,
principalmente, los recursos humanos, los materiales y productos, y el equipa-
miento y la maquinaria.

ProjectLibre distingue dos tipos de recursos:

e Trabajo (Work). Son recursos cuyo coste depende de las horas de trabajo
empleadas para completar una tarea. Corresponde a la mano de obra, las
empresas subcontratadas o la maquinaria.

e Material (Material). Son recursos cuyo coste depende de la cantidad necesa-
ria de materiales para completar una tarea. Estos llevan asociada una unidad
de medida (ud., m, m?, kg, litros, etc.), que debe ir indicada en el campo
Etiqueta de material (Material Label) del formulario o Tabla de recursos,
descrita a continuacion.

Solo una vez introducidos los recursos, puede ser anotado su coste.

e Los costos fijos asociados a una tarea concreta que no dependen de la cantidad
de trabajo, duracion de la tarea o cantidad de material, pueden insertarse
como recurso de tipo Material. Hay que definir la cantidad de 1 y ud. como
Etiqueta de material. Ejemplo: gastos de representacion (gastos de viaje,

dietas por comida, etc.), licencia de obras, seguro de la obra, etc.

6.1. Tabla de recursos

Para insertar los recursos, hay que acudir al menu Resource y clicar en la tabla
Resources. Se abre un panel con diversas columnas ya insertadas por defecto (fi-
gura 32).
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{ ProjectLibre. NES )
File Task

Ed rES @, Zoom Out Copy || & Insert | b= Indent | 4 Information 4% Find
[%3 Resource Usage . Cut @ Delete | 4 Outdent | ™ Calendar

Resources %, ZoomIn Paste ™| Notes

Resource | View

Views Clipboard Resource

@ Name RBS = Type E-mail Address = MaterialLabel = Initials Group Max. Units Standard Rate = Overtime Rate  Cost Per Use Accrue At Base Calendar

Figura 32.
Tabla de recursos

Las columnas que conforman la Tabla de recursos son:

e [nformation: muestra los avisos mediante iconos o indicadores.

e Name: nombre del recurso.

e RBS: estructura de descomposicion de los recursos (Resource Breakdown
Structure). Diagrama de flujo que muestra la agrupacion y relacion entre los
recursos.

e Type: tipo del recurso, Work o Material.

e E-mail address: direccion de correo electronico del recurso.

e Material label: etiqueta de material, donde se especifican las unidades en las
que se cuantifica el recurso.

El coste del material viene definido por la unidad monetaria €/Material

Q Label. Por ejemplo, si se trata del material cemento y se mide en kg, se debe
insertar el texto «kg» en el campo «Material Label», de manera que el costo
se computara en €/kg.

e [nitials: iniciales del recurso, para una identificacion mas corta del mismo.
Especialmente Util cuando queremos visualizar los recursos asignados a
cada tarea en el diagrama de Gantt. Por ejemplo, pueden emplearse letras
mayusculas para los recursos de tipo Work y letras mintusculas para los de
tipo Material.

e Group: grupo al que pertenece el recurso, por ejemplo: Departamento técni-
co, en el caso de recursos de tipo Work; Morteros y hormigones, en el caso
de recursos de tipo Material.

e Max. Units: disponible para los recursos tipo Work, indica las unidades
maximas disponibles del mismo, o lo que es lo mismo, su capacidad de tra-
bajo. La capacidad méaxima puede variar con el tiempo, de manera que un
trabajador puede trabajar con una capacidad diferente a partir de una fecha
determinada. Ello puede configurarse en el didlogo Resource information >
Resource Availability, al que se accede con doble clic sobre el nombre del
recurso o desde la barra de herramientas en la pestafia Resource.
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%% Resource Information

General Costs Resource Availability Tasks Notes

Mame: |Project Manager

Available From

01/01/70 00:00
13/04/20 00:00

e Standard Rate: es la tasa o coste por unidad de tiempo para recursos tipo
Work, en €/h o €/d, y el coste por unidad consumida para recursos
tipo Material, en €/unidad (siendo la unidad, aquella definida en la columna
Material label).

e Overtime Rate: es el coste de las horas extra de los recursos de tipo Work,
en su caso.

e (Cost Per Use: es el coste fijo a imputar cada vez que un recurso, Work o
Material, se asigna a una tarea, independientemente de las horas o unidades
utilizadas.
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e Accrue At: indica cuando se van a imputar los costos asociados al recurso y
ProjectLibre distingue entre tres opciones:

- Start: al inicio, el coste del recurso se imputa al comenzar la tarea.

- Finish: al final, el coste del recurso se imputa al finalizar la tarea.

- Prorrated: prorrateado, el coste del recurso se imputa equitativamente a
lo largo del desarrollo de la tarea. Esta es la opcion mas habitual y prede-
terminada por el programa.

e Base Calendar: es el calendario especifico escogido para el recurso, si se
desea que sea diferente al definido para el proyecto. Los calendarios de los
recursos pueden ser particularizados de forma individual, seleccionando el
recurso y clicando en Calendar, en la pestafia Resources. Los cambios en
el calendario del recurso pueden realizarse siguiendo las mismas pautas que
para crear un calendario, definidas anteriormente. Dichos cambios Unica-
mente afectardn al recurso.

5 Task Information - 22

General Predecessors Successors Resources Advanced  Notes

Name: |Tarea cuadrila albafiiles|

vos: E— = T —

Constraints
AsSoon AsPossble  + | ConstraintDate:| =

e ook | chontiven
Task Calendar: [] Ignere Resource Calendar)
comes e et Coriee |
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Para insertar un recurso, basta con introducir el nombre del recurso en el cam-
po Name 'y completar el resto de informacion en los campos de la propia Tabla de
recursos. Las acciones en las columnas (insertar u ocultar) y en las filas (despla-
zar, insertar o eliminar) son las mismas que para la Tabla de tareas. Los recursos

también pueden estructurarse y organizarse en el listado, mediante las acciones
b Indent
< Outdent

La informacion propia de cada recurso puede ser también introducida y consul-
tada en el didlogo Resource Information, al que se accede con doble clic sobre el
nombre del recurso o desde la barra de herramientas en la pestafia Resource (véase
figura 35).

o

& Resource Information x

General Costs Resource Availability Tasks Motes

MName: Project Manager| Initials: PM
E-mail Address:  pm@uji.es Group:
RBS: [ Generic
Type: Work s | Material Label;
Base Calendar: | CalendariollJI v |EE

Figura 35.

Informacién del recurso

En la pestafia Resource Availability se pueden introducir las fechas en las que
el recurso se encuentra disponible, y en Tasks se muestran las tareas en las que el
recurso estd asignado (una vez se ha realizado la asignacion, como se vera mas
adelante).

6.2. Tablas de tasa de costo

Cabe indicar que los costos de los recursos pueden variar durante el desarro-
llo del proyecto y también dependiendo del tipo de tarea a realizar. Para ello, se
emplean las Tablas de tasa de costo (Cost Rate Tables), las cuales se introducen
en el dialogo Resource Information, pestaiia Costs, en las diferentes pestafias que
se muestran (A, B, C, D y E), en las que, a su vez, pueden definirse diferentes
Standard Rate y Overtime Rate 'y Cost Per Use. Ademas, también pueden especifi-
carse las fechas a partir de las cuales dicha tasa se hara efectiva (véase figura 36).
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i Resource Information X

General Costs Resource Availability Tasks Notes

Mame: |Project Manager

Cost rate tables
AlB|C|D|E
EffectiveDate Standard Rate Overtime Rate Cost Per Use
01/01/70 00:00 € 35,00/hour £ 40,00/hour £0,00
06/04/20 00:00 € 37,50/hour € 45,00/hour €0,00

Figura 36.
Tabla de tasa de costo

Las tablas de tasa de costo van vinculadas al recurso y a la tarea, por lo que es
necesario previamente asignar el recurso a la tarea para seleccionar qué tasa se
desea aplicar. Ello se detalla en apartados posteriores.

Cabe indicar que las tablas de tasa de costo no se pueden mostrar como colum-
na en la Tabla de recursos, sino que debe accederse al ment de la figura 36 para
definirlas y visualizarlas, como se ha indicado anteriormente.
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/. Asignacion de recursos
a tareas

Una vez creados las tareas y los recursos del proyecto, se procede con la asigna-
cion de los recursos a las tareas. La asignacion de recursos consiste en asociar
aquellos recursos, tanto de tipo Work como Material, y sus costos, a las tareas para
las que son necesarios en su desarrollo. Cada vez que un recurso esta asignado, en
la vista Tabla de recursos, aparece sombreado en verde y queda indicado con el
simbolo ¢+3, tal y como se muestra en la figura 37.

@ Name RBS Type E-mail Address Material Label Initials Group Max. Unit
1 Project Manager Work braulo@uji.es PM Técricos
2 ) Ingeniero Work ingeniero@projecto.es Ing Téanicos
Figura 37.

Tabla de recursos asignados

Cabe tener en cuenta que la forma en la que se asignan los recursos (orden y ca-
pacidad) y el tipo o naturaleza de tarea, condicionara la programacion de la tarea.

7.1. Proceso de asignacion de recursos a tareas

ProjectLibre ofrece dos caminos para asignar recursos a tareas que conducen al
mismo didlogo (véase figura 38):

e Desde el didlogo Task Information > Resources > Botdn Assign Resources
Bl

e Desde el menu 7ask > Boton Assign Resources.

Para realizar la asignacion, se selecciona el recurso, se incorpora en el campo
Units el valor correcto y se clica en ¢ o0 Assign. Para eliminar un recurso, se selec-
cionay clica en ¢ o Remove.
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Fiipal
cher

Geneval (B Assign Resources 0
Mame: |Tar Tasks: 22 I
Resources: Hame Units CE
Dani 00% | g
Alba x Jnmen...
Juan Py 0 days
Sara 0 days
Ladrillo 200u Remove D ey
Cuadrilla de albafiles | 300%] Replace...
Help
Figura 38.

Asignacion de recursos a tareas

Como se observa en la figura 38, en el caso de los recursos humanos la asigna-
cion tiene la unidad porcentual %, mientras que en el caso de los materiales, las
unidades corresponden a la unidad definida previamente en Material Label.

Los equipos de trabajo, como por ejemplo las cuadrillas de albaiileria, el
equipo de ingenieria, etc., pueden crearse como un Unico recurso con una
asignacion de 100 % x N.° de personas que integran el equipo.

Las tablas de tasa de costo, Cost Rate Tables, se pueden seleccionar una vez el
recurso ya ha sido asignado a la tarea, desde la pestafia Resources del didlogo Task
Information, como muestra la figura 39. El coste de la tarea, por tanto, se calculara
aplicando la tasa correspondiente asociada al recurso.
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s Task Information - 22 X

General Predecessors Successors Resources Advanced Notes

Name: Tarea cuadrilla albafiles

Resources: B C:
Name Work Work Contour Assignmen... Leveling D... Cost Rate Table
Dan 2 hours Flat 0days
Ladrillo 200 Flat 0days
Cuadrila de albadies 6 hours Flat 0days
Figura 39.

Asignacion de tablas de tasa de costo

7.2. Calculo de la programacion de las tareas: la formula
del trabajo

La programaciéon de un proyecto se calcula en funcion de tres variables que
vienen definidas segun la siguiente expresion o formula del trabajo (figura 40).

TRABAJO = DURACION x UNIDADES
b
e ses 808
[AA LLLLLLL
horas dias % de asignacién

Figura 40.
Férmula del trabajo

Estas son:

e Trabajo (Work): cantidad de trabajo o esfuerzo en horas necesarias para lle-
var a cabo una determinada tarea.

e Duracion (Duration): tiempo necesario, en dias, para completar una tarea.

e Unidades (Units): unidades de recursos tipo Trabajo (Work) asignadas a una
tarea para su desarrollo, considerando su % de capacidad (por ejemplo: 100
%, cuando la dedicacién es a tiempo completo; 50 %, cuando es a media
jornada; etc.).
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Al introducir una tarea, una de las tres variables queda fijada, de manera que
al introducir el valor de la segunda variable, ProjectLibre determinard la tercera
variable. Existen tres tipos de tareas en funcion de la variable que se desea fijar.
Se describen a continuacion los tres tipos de variables y como ProjectLibre opera
en cada una de ellas:

o Tarea de unidades fijas (Fixed Units): El porcentaje de trabajo que un recur-
so puede dedicar a la tarea no cambia si varia el trabajo o la duracion. Es el
tipo por defecto en ProjectLibre, cada vez que se inserta una nueva tarea.

Juan, administrativo contratado a media jornada, dedica 4 horas diarias

IE de trabajo a un proyecto determinado (siendo la jornada laboral de 8 h/

Bj. 11 dia). Por tanto, las unidades asignadas del recurso Juan son del 50 %.

' Independientemente del trabajo que suponga la tarea que tiene encomendada

o de su duracion, Juan no puede dedicar mas del 50 % de su capacidad a
dicha tarea.

e Tarea de duracion fija (Fixed Duration): El tiempo que tarda una actividad
no cambia, independientemente de cuantas horas laborables o recursos se
asignen.

La tarea «Congreso final del proyecto» tiene como objetivo presentar sus

IE resultados y tiene una duracion de 3 dias. Se pueden asignar mas recursos

Ej. 12 a dicha tarea (por ejemplo, n.° de participantes) y horas de trabajo, pero la
: duracion permanecera fija en 3 dias.

e Tarea de trabajo fijo (Fixed Work): El esfuerzo o trabajo necesario para lle-
var a cabo una actividad (en términos de horas) no cambia, independiente-
mente de las unidades del recurso o la duracidén. A medida que se asignan
mas recursos, la duracion se vera reducida, y a la inversa. Por defecto, las
tareas de trabajo fijo son tareas condicionadas por el esfuerzo.

La tarea «Construccion de 20 m? de tabique de ladrillo» la ejecuta 1 unico
IE operario en | dia, invirtiendo 8 horas. Si se le suma una compafiera, las
Ej. 13 unidades asignadas aumentan al doble (100 % del primero y 100 % de la
: segunda) y podran finalizar la actividad en la mitad de tiempo, es decir, en

4 horas.

El tipo de tarea se selecciona desde la pestafia Advanced del menu Task
Information (véase figura 41). Junto al menu desplegable del tipo de tarea esta
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la casilla Condicionada por el esfuerzo (Effort Driven), la cual aparece activada
siempre por defecto. Hay que tener en cuenta el desactivarla cuando proceda.

General Predecessors Successors Resources Advanced  Notes

Mame: |3 REUMION duradidn fija

WBS: [] Display task as milestone
Constraints
Constraint Type: As Soon As Possible ~ Constraint Date: -
Deadline: A
Type: Fixed Duration v [ ] Effort Driven
Task Calendar: w [ 1gnore Resource Calendar
Earned Value Method: | %6 Complete v
Figura 41.

Tipos de tareas y tareas condicionadas por el esfuerzo

iilmportante!! Previamente a asignar recursos a tareas, es muy importante
A asegurarse de que la naturaleza de todas las tareas es la que corresponde, para
que ProjectLibre programe de forma coherente.

O Conviene afiadir las columnas Type y Effort Driven a la Tabla de tareas
= para visualizar junto al nombre de la tarea su tipo y no perder de vista qué
programacion se aplica en cada caso.

La tabla 6 muestra la variable que ProjectLibre calcula automaticamente al mo-
dificar una de las variables de la programacion, para cada tipo de tarea:
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Tabla 6. Comportamiento de las variables de la féormula del trabajo segun tipo de tarea

Tipo de Al modificar Al modificar Duracion Al modificar Trabajo

tarea Unidades
Unidades  Cambios enla  Cambios en el Trabajo Cambios en la Duracion
fijas Duracion
Trabajo Cambiosenla  Cambios en las Cambios en la Duracion
fijo Duracion Unidades del recurso

(%)

Duracion ~ Cambios enel ~ Cambios en el Trabajo Cambios en las Unidades
fija Trabajo (por defecto) del recurso (%)

Como se ha indicado anteriormente, una farea condicionada por el esfuerzo
implica que la cantidad de trabajo necesaria para completar la tarea no varia, inde-
pendientemente de cudntos recursos se le asignen.

Se analizan dos casos:

=~

Ej. 14 a) Actividad condicionada por el esfuerzo: a una empresa se le realiza un

pedido de 2.000 unidades del producto que fabrica. La plantilla puede
fabricar 10 unidades por hora, por lo que cumplir con el pedido implica
200 horas de trabajo. Con 1 recurso que dedica 8 horas/dia, se tardaria
25 dias laborables en finalizar, mientras que si se asigna 1 recurso mas,
se tardaria 12,5 dias, con otro adicional, 6,25 dias; y asi sucesivamente.
La duracion de la tarea depende, por tanto, de los recursos que tenga
asignados, porque la cantidad de trabajo es fija.

b) Actividad no condicionada por el esfuerzo: una empresa con la una
linea de montaje de un producto activa durante 5 dias laborables. Con
1 recurso asignado, la tarea representaria 40 horas de trabajo. Si se
asignan 2 recursos, la tarea representaria 80 horas.

En el caso a) el trabajo es el mismo, no varia, y la duracion de la tarea
dependera de los recursos que haya asignados. Mientras tanto, en el caso b)
el trabajo si varia y depende de los recursos que haya asignados a la tarea,
asi como de su duracion.

Hay que tener en cuenta que, ademas de influir el tipo de tarea en el compor-
tamiento de la programacion, el hecho de ser o no condicionada por el esfuerzo,
también afecta de forma diferente a su comportamiento. Cuando la tarea es condi-
cionada por el esfuerzo y se asignan recursos adicionales, la duracion o las unidades
asignadas a cada recurso se recalculan segun corresponde. La tabla 7 presenta un
resumen de como una tarea se comporta al modificar la asignacion de recursos:
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Tabla 7. Comportamiento de las variables segtn tipo de tarea

Variable afectada

Condicionada por el esfuerzo No condicionada por el esfuerzo

Unidades Duracién Trabajo
fijas + recursos — — duracion + recursos —> + trabajo
Trabajo Duracién

fijo + recursos — — duracion

Unidades del recurso Trabajo

Duracion ..,
fija + recursos — variacion %
de asignacion

+ recursos — + trabajo

O Las nuevas tareas creadas en ProjectLibre son, por defecto, de tipo unidades
= fijas y condicionadas por el esfuerzo. Se debe tener en cuenta, cuando proceda,

el activar/desactivar la casilla de tarea condicionadas por el esfuerzo, y
seleccionar el tipo adecuado de tarea.

7.3. Visualizacion de recursos asignados

A medida que se asignan recursos a tareas, existen varias formas de visualizar
qué recursos quedan asignados:

1. En la columna Resources de la Tabla de tareas.

2. Junto alas barras del diagrama de Gantt. Cada nombre del recurso se mues-

tra con su % de asignacion o unidades. Cuando se trata del 100 %, este no
se muestra.

e\ []
[ ProjectLibre.. ) .

File

Actividads-FormulaTr... ~

Task Resource View il & E?I'I @ l:l (7]

fmpnd Network @ ZoomIn Copy || & Insert | - Indent & Link # Information ﬂii Assign Resources ¢ Find
Fu WEBS . Zoom Qut l i, Cut e Delete | ¢ Outdent | <. Unlink | ™™ Calendar  Save Baseline '+ Sooll To Task

Gantt | 53 Task Usage Paste T | Notes Clear Baseline Update

Views Clipboard Task

® Name Type Work Duration Resource Names Cost 6 dabr. 20 13 dabr. 20 20 dabr. 20
bbb bbb bbb bbbbbbbhbh
28 Tarea administrativa Fixed Units 4hours 1 day? Juan[50%] €32,00 Juanl50%] ~
29 Congreso final del proyecto  Fixed Duration 56 hours 3 days Dani[67%];Alba[67%]);Juan | €512,00 Danil67%]:Alba[67%]:Juan
30 Tabique de ladrilo Fixed Work 8 hours 0,5 days? Dani;Ladrilla[200 u];Alba € 200,00 E ]:;hni;l_ adrillo[200 ul:Alba
Figura 42.

Visualizacion en el Gantt de los recursos asignados a las tareas
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3. Show Assignments. Desde el didlogo del boton derecho del raton sobre el
Gantt, se puede activar la opcion Show Assignments, que mostrara un des-
glose detallado de los recursos asignados a cada tarea, tanto en la Tabla de
tareas como en el Gantt, en este ultimo con barras de color naranja. Este
modo de visualizacion resulta muy util durante la asignacion de recursos,
para ver en detalle las horas de trabajo, duracion y coste asociados a cada
uno de los recursos que intervienen en la tarea. Véase la figura 43.

~
= \

ProiectLl.bre ‘.I‘m - ' Actividadé-FormulaTr...
- File Task Resource View @ l:l 0

[l Network @ ZoomIn Copy Insert | p- Indent Link - Information mid Assign Resources 4% Find
* ]
WBS A, Zoom Out g7 Jb Cut &= Delete | ~q Outdent | . Unlink | "™ Calendar Save Baseline " Scroll To Task
Gantt | [E Task Usage

Paste T | Notes Clear Baseling Update

Views Clipboard Task

@ Name Type Work Duration Resource Names Cost £ dishr. 20 5 5 120 dabr. 20
bbb bbb bbb bbb bbb bbb
3 Tarea administrativa Fixed Units 4 hours 1 day? Juan[50%] €32,00 E Juan[50%] ~
Juan 2hours Iday €200 |
2 Congreso final del proyecto  Fixed Duration 56 hours 3 days Dani[67%];Alba[67%];Juan | €512,00 Dani[67%]:Albal67%]:Juan
Dan 16 hours Fdays € 160,00
Aba 16 hours Fdays € 160,00
Juan 24 fours Fdays € 192,00 E
30 Tabique de ladrillo Fixed Work 8 hours 0,5 days? Dani;Ladrillo[200 u]; Alba €200,00 E Dani;Ladrillo[200 ul:Alba
Ladrilo 200 0.25days e12.00|| i
Dan 4 hours 0,5days €40,00
Alba 4 hours 0,5 daps £40,00
Figura 43.

Visualizacion de asignaciones detalladas en el Gantt (Show Assignments)

7.4. Costos

ProjectLibre calcula automaticamente los costos asociados a cada tarea y al
proyecto, en general. Para visualizar la informacién relativa a costos conviene
insertar la columna Cost en la Tabla de tareas, tal y como se muestra en la figura
43. El campo coste es la suma de:

o C(Costes variables: son los que dependen del rendimiento de trabajo e inclu-
yen, basicamente, la mano de obra y los materiales. Se calculan mediante la
Standard Rate, multiplicando dicha tasa por el nimero de horas que invierte
el recurso (para recursos de tipo Trabajo) o por unidad (para recursos de tipo
Material). Cuando un recurso tiene diferentes 7ablas de tasa de costo, la tasa
asignada a la tarea es la que se tiene en cuenta para calcular el coste. Cuando
un recurso lleva asociado un costo cada vez que se usa, se debe introducir
dicho costo en el campo Cost per Use, de manera que este solo se imputara
una vez a lo largo de toda la tarea a la que estd asignado.

o C(ostes fijos: son aquellos que permanecen invariables a lo largo de toda la
duracién del proyecto; por ejemplo: seguros, gastos derivados de alquile-
res inmobiliarios, permisos y licencias, mantenimiento de equipos, facturas
mensuales de suministros, administracion, etc. Estos pueden introducirse
en el campo o columna Fixed Cost (Coste Fijo) de la tarea a la que van
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asociados, aunque cabe indicar que ProjectLibre no los imputa al coste total
del proyecto. Alternativamente, también pueden introducirse en los campos
Standard Rate 'y Cost per Use de un recurso de tipo Material creado para tal
efecto y asignar este recurso a una tarea especifica para imputar los costes
fijos al proyecto.

Otra manera de visualizar los costos es mediante la propia Tabla de costos. Se
accede pulsando clic con el boton derecho del ratdon en la primera celda superior iz-
quierda de la vista Gantt (figura 44) y seleccionando Cost del ment desplegable.

Name Cost Actual Cost Fixed Cost Baseline Cost Fixed Cost Accrual

EIPROYECTO NAVE INDUSTRIAL
Pe
Fit

1 €0,00 End
2

3

4 BR,

5

3

7

8

€0,00. End
€587,00 €0,00 End
€636,00 €0,00 End
€0,00. End
€0,00 End
€0,00 End
€0,00 End
€0,00 End
€0,00 End
€0,00 End
€0,00 End
13 I Schedule (CPM) €0,00 End
14 I Schedule Variance €0,00 End
15 @G Summary €3474,75 €0,00 €3474,75 €0,00 End
€0,00. End
€0,00 End
€0,00. End
£nnn End

Baseline

Constraint Dates ———
€ 636,00
87 Cost (Click to rename)
| Default
| EamedValue
| Eamed Value - Cost
" Eamed Value - Schedule
I

Ejecucién de nave industrial

Name

Tracking

Work
3 ig6n de lmpi

Figura 44.
Tabla de costo

El modo en el que se imputan los costos de los recursos a las tareas depende
del tipo de costo y de recurso. Existen varias casuisticas, como se describe a
continuacion:

e Caso 1. Para los recursos que tienen un coste fijo y que solo se asignan 1 vez
durante el proyecto. Se puede introducir un recurso con un Cost per Use (de-
jando a cero € el resto de campos). Seria, por ejemplo, el caso de permisos,
licencias, seguros, etc., en € totales.

Standard Rate Overtime Rate Cost Per Use
€0,00 €0,00 € 10000,00

Figura 45.
Caso 1: coste fijo

e Caso 2. Recursos que tienen un coste variable diario, independientemente de
cuanto tiempo los utilizas al dia. Se puede introducir como recurso Material
y el coste en el campo Cost per Use (dejando el resto de campos del recurso
a cero €), de manera que las unidades asignadas del recurso corresponde-
rian al nimero de dias de uso del recurso. Seria, por ejemplo, el caso de
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alquiler de maquinara o equipamiento, alquiler de un espacio para realizar
un evento, empresa subcontratista, etc., con coste contabilizado en €/dia, con
Units = dias.

EffectiveDate Standard Rate = Overtime Rate Cost Per Use

€0,00 €0,00 € 150,00

Figura 46.
Caso 2: coste variable diario

e Caso 3. Coste fijo + coste variable en funcion del uso. Seria el ejemplo del
alquiler de un coche, maquinaria o espacio, en el que se paga una tasa fija o
fianza al inicio por dicho alquiler y una tasa variable en funcion de los dias
de alquiler o el kilometraje realizado. Se imputa en € + €/dia. Para ello, se
debe crear un recurso de tipo Trabajo e introducir en el campo Cost per Use
el coste fijo (coste a imputar por cada vez que se emplea el recurso) y en el
campo Standard Rate, el coste variable. Por ejemplo, el alquiler de una case-
ta de obra cuesta 30 €/dia (3,75 €/hora, si la jornada es de 8 horas) y tiene un
coste fijo de 250 € en concepto de suministro a obra por parte del proveedor.
En Standard Rate se introduce 3,75 €/hora y en Cost per Use 250 € (véase
figura 47).

%% Resource Information

General

Resource Availability Tasks MNotes

Mame: |Alguiler maquinaria

Cost rate tables

AB|C|D|E

EffectiveDate Standard Rate Overtime Rate CostPer Use
01/01/70 00:00 € 3,75/hour €0,00hour € 250,00

Figura 47.
Caso 3: coste fijo y coste variable segtn el uso

Si ademads se deseara introducir algin otro coste fijo asociado al recurso,
como podria ser, siguiendo con el ejemplo anterior, el coste de un servicio de
reparacion de la caseta de obra, disponible durante toda la utilizacion
del recurso, este podria introducirse como un recurso «ficticio». Para crear
un recurso «ficticio», se deben seguir los siguientes pasos:

e Insertar un recurso tipo Material y (recomendacion) nombrar el recurso in-
cluyendo las iniciales RF (Recurso Ficticio) antes del nombre, para identifi-
carlo y no inducir a confusion.
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e Seleccionar el modo de imputar el coste (Accrue At) al inicio, final o prorra-

teado, segln proceda.
¢ Insertar el costo en el campo Cost per Use.

Name RBS Type Material Label Ini.. Group Un... Standard Rate Overtime Rate Cost PerUse Accrue At
Maquinaria de obra Work M 100%  €1,25hour €0,00hour € 100,00 Prorated
RF reparacion maguinaria Material R €0,00 € 200,00 End

@  wss Name Cost Duration
€ 500,00 20 days

Maguinaria de obra € 300,00 204,

RF reparacon maguinana £€.200,00 20 dla)

*
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e N 30 de mar; 20 abr.
Maquinaria de obra Cost
Tarea con magui Cost
RF reparacién maguinaria Cost
Tarea con maguinana Cost
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8. Visualizacion del proyecto

Llegado el punto de la programacion en el que las tareas, los recursos y los costos
ya estan introducidos en el programa, ProjectLibre ofrece diferentes formas de
visualizar la informacion. A la mayoria de estas vistas se puede acceder desde la
pestafia View (figura 51).

- ~

- - \\ !:‘ N &
{ ProjectLibre. ) -
File Task Resource View

= Metwork RBS [=] Projects || i Histogram Resource Usage || Mo Filter v
WBS Resource Usage Repart =% Charts [1 Mo sub window || Mo Sorting v
Gantt 3@ Task Usage || Resources [¥3 Task Usage Mo Group v
Task views Resource views Other views Sub-views Filters
Figura 51.
;e
Menu Vista

O Cuando se manejan proyectos grandes con una duracion larga, las barras de
= las tareas del diagrama de Gantt pueden no estar completamente visibles.
. Para desplazarnos de forma directa y rapida a la barra de la tarea que se

desea visualizar en pantalla, es util emplear el comando Scroll to Task
“== seroll To Task, disponible en el menu Task.

8.1. Visualizacion de tareas

Muchas de las vistas ya se han descrito anteriormente, por lo que se comentan a
continuacion ciertas particularidades y nuevas opciones de visualizacion.

e Gantt: un clic con el boton derecho del raton en la primera celda de la Tabla
de tareas permite acceder a un menu para seleccionar diferentes configura-
ciones de la tabla. La vista que tiene el nombre del fichero (que se le ha dado
por defecto al crear el fichero), es la que se configura de forma personalizada
con las columnas insertadas por la usuaria, como se observa en la figura 52.
Todas las opciones de visualizacion de la Tabla de tareas se muestran en
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dicha figura. Son especialmente interesantes las opciones Cost (coste), Work
(trabajo), Tracking (seguimiento), Earned Value (valor ganado) y Summary

(resumen).
- - N ) Obra v
{ ProjectLibre. ) ' .
Fle  Tak  Resouwce | View @ (7)
[&1] Network — RBS [=] Projects || (] Histogram  [EJ Resource Usage || No Filter v
& wes K|  [TResource Usage || [TIReport || A Charts  []Nosubwindow || NoSorting v
Gantt [¥g TaskUsage || Resources [¥E} Task Usage No Group v
Task views Resource views Other views Sub-views Filters
i b d'abr. 20 13 d'abr. 20 20 d'abr. 20
[ e b bbb bbbhbobbbhbiobbbb
1 1 EMovimiento de tierras 11,875 da| A
2 - Baseline del terreno 11,875dg
= Constraint Dates = 254
4 e tierras 0d
5 sy 7,75 dal
6 Default bs 1,5d4
7 Earned Value B 1d
8 Earned Value - Cost adores sobre el hormigén de impieza 0,25¢
9 Earned Value - Schedule 29
10 0 Name (tiempo transcurrido) 3q
® Obra (Click to rename)
Schedule (CPM)
Schedule Variance
Summary
Tracking
Work
Figura 52.

Opciones de vista de la Tabla de tareas

e Network: muestra el diagrama de red PERT, en el que cada tarea viene repre-
sentada por un recuadro con informacion sobre el nombre, la duracion y las
fechas de inicio y fin. Las tareas resumen se representan con un romboide de
contorno en color negro, las normales con un rectangulo en azul, las criticas
con un rectangulo en rojo, los hitos con un rombo ¢ negro y las dependen-
cias mediante flechas, como muestra la figura 53.

fMovimiento de tierras Diesbroce y Limpieza del terreno:
Duration 11,875 days? Datafion. 11,875 dajs?
sart  26032005:00 St 280320 0800

Finish -~ 10:0+20 16:00

Finish 100420 16:00

Excavacion de zapatas

. . Fin de movimiento de tierras
” Durai B Duration 0 days

Start 0 sart 0204201300

Finish - - 620430 13:00 Eh 020420 13:00

Cimentacion " Enafiado dé zapatas ! " Hottigon de limpieza’ | |
" Dirai : : | | Duinian 1t
: ©StartD | 060420 08:0D
Emich o430 1700

Figura 53.
Network o Diagrama de red PERT

e J/BS: muestrala Estructura de Descomposicion del Trabajo (Work Breakdown
Structure) que establece la organizacion de tareas y el coste asociado a
cada una de ellas (figura 54). Permite modificar la relacion de dependencia
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y la jerarquia entre tareas, haciendo clic y arrastrando el cursor entre los
recuadros.

Reuniones de la D.F. Movimiento de tierras

Cost €530,00 Cost €2243.02
Budget Budget
¥ ¥ ¥ ¥ ¥
Reunién 3 Reunién 4 Reunidn § Deshroce y limpieza del ... Excavacién de zapatas
Cost €106,00 Cost €106,00 Cost € 106,00 Cost €160132 Cost €642,60
Budgst Budget Budget Budget Budgst
Figura 54.
WBS/EDT

e Task Usage: muestra el uso de las tareas y su distribucion en el calendario
(hasta detalle horario). En el panel de la derecha, con un clic derecho del
cursor en la primera celda, se puede seleccionar en el menu desplegable el
parametro que se desea visualizar (Work, Cost, Baseline Cost, etc.).

. . | m I
ProjectLibre. - —
Task  Resource | view
P81 Network 6 RBS [= Projects || il Hetogram  [F4 Resaurce Usage || No Filter >
5 wes [¥H Resource Usage || [TIReport || CHCharts [ ]Nosubwindow || No Sorting -
Gantt [T Task Usage || Resources [ Task Usage No Group ~
Task views [ Resource views Other views || Sub-views Fiters
Name Work Duration Start Finish Work Contour Assignmen... Leveling D... Cost Rate Table F £ B B E B E‘J dechan IDZ‘
1 EMovimiento de tierras 70 hours 11,875 day... 26/03/20 08:00  10/04/20 16:00 0days Work &h sh oh oh 2h
2 Desbroce ylimpiezadelter  S0hours 11,875 dave? 26/03/2008:00  10/04/20 16:00 0days o Work gh gh h 2 *
3 Excaveudn de zapalas 20 howrs 2,5days? 31/03/2007:00  02/04/20 13:00 Qdays. Cost
) Fin de movimiento de tierra 0hours 0days02/04/20 13:00  02/04/20 13:00 0days kil Gk
5  EGmentacion 62hours 7,75 days? 02/04/20 13:00  18/04/20 10:00 0days
3 Encofrado de zapatas 12hows  1,5days?02/04/20 1300 03/04/20 17:00 0days fetunl. Work
7 Hormigén de lmpieza 8hours 1day? 06/04/2008:00  06/04/20 17:00 0days BaseheCon
[ Colocacitn de separadores 2hours  0,250ays07/042008:00  07/04/20 10:00 0days Baseline Work
[ Hormiganade 16 hours 2days 07/04/20 10:00  09/04/20 10:00 0daye BCWP
10 Fraguadohormigdn (bemp« 24 hours 3days 090420 10:00  14/04/20 10:00 0days BCWS

Figura 55.
Uso de tareas

8.2. Visualizacion de recursos
Desde el ment Recursos, puede visualizarse lo siguiente:

e Resources: contiene la lista de recursos y sus atributos.

e RBS: muestra los recursos esquematizados mediante un diagrama de flujo
(st se han insertado grupos en la Tabla de recursos), como en la figura 56.
Permite modificar la relacion de dependencia y la organizacion de los recur-
sos, haciendo clic y arrastrando el cursor entre los recuadros.
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Equipo técnico
ot €m0

Buigt €00
Project Manager Ingeniera Arquitecto Técuico Jefa de obra Peinl Peona 2 Cuadrilla de estructuris..
ot 1500 ot e50 ot es0 ot £220 ot el e ot 1000
Budget £0.00 Budget £0.00 Budget £0.00 Budget £0.00 Budget £0.00 Budget £0.00 Budget £0.00

e Resource Usage: muestra la distribucion del trabajo asociado a cada recurso
y plasmada en el calendario (hasta detalle horario). De la misma forma que
en la Tabla de tareas se puede visualizar el parametro deseado (figura 57)
haciendo clic derecho en el cursor.

= = N=EN D
[ ProjectLibre, ) :

Task

= File Resource View
= Network RES [=]Projects || luitl Histogram  [E3 Resource Usage || Mo Filter v
WBS [E& Resource Usage || [ Report Charts [ no sub window || No Sorting o
Gantt % TaskUsage || Resources [E3 Task Usage No Group -
Task views Resource views Other views Sub-views Filters
Name ‘Work Wor... Assignmen... Leveling D... Cost Rate Table 23 de marg 20 |50 de
I I I o I I Io
1 BETécnicos 40 hours Work oh oh oh 6h oh oh oh
2 Project Manager 5 hours Work *  Work 0h ih 0h Oh Oh
Reunign 5 1 hour Aiaf Odsys OdsysRate A Waork Cost
Reurnidn 5 1 hour Flat Odays OdaysRate A Work Actual Cost
Reunidn 2 1 hour Aiat Odays OdaysRate A Work
= Actual Work
Reunion 1 1 hour Aiaf Odsys OdsysRate A Waork ik
Rewnidn 5 1 hour Fiat adays 0 cbys Rate A Work Baseline Cost
3 Ingeniera 13 hours Work Baseline Work |y,
Reunign 5 1 hour Aiaf Odsys OdsysRate A Waork BCWP
Reunidn 1 1 hour Fiat Odays 0 days Rate A Waork BCWS |
Firma del Acta de Replan & hours Fat Odays OdaysRate A Work
Figura 57.

Uso de recursos

8.3. Vistas combinadas

superior derecha de la interfaz del programa [yi%] [&] [ER||

Cada una de las vistas anteriores puede combinarse con las subvistas disponi-
bles en el apartado Sub-views, mostradas tanto en la pestana View como en la parte

| . Estas son:

. Histogram: muestra el histograma de uso de cada recurso del proyecto.
Al seleccionar una tarea, los recursos asignados a dicha tarea aparecen resal-
tados con el simbolo @. El filtro permite seleccionar el tipo de recurso por
visualizar. La leyenda de colores significa lo siguiente:

Gestion de proyectos con ProjectLibre™
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Selected (barra azul): asignacion del recurso seleccionado.

This Project (barra verde): asignacion del recurso en la tarea seleccionada.
Resource Availability (linea negra): indica el % de capacidad méaxima del
recurso distribuido en el calendario.
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@ wes Name Tr= Effort Work Duration ' 20 [30 de marg 20 |6 d'abr, 20 13 dabr, 20
. pobbbpbbbbbbbbbbbbbbbblbT
11 4.1 Pesbroce y impiezz del terreno Fixed Work 112 hours 56daf| | aém 1:Retroexeavadora;Pasm 2
12 4.2 Excavacidn de zapatas Fixed Work 40 hours! 2da eon 1:Retroexcavadora:Peon J|
13 4.3 Fin de Movimiento de tierras Fixed Work 0 hours Oda Ti04
14 3 E Cimentacién Fixed Work 140 hours| 7,583 day:
15 3.1 Encofrado de zapatas ixed Wark 0 hours 2da
16 3.2 Hormigén de limpieza d Work = 4hours| 0,333 davi| !
< >«
3 \
Resource Filter: Mo Filter \v Show Selectedon Top  » arg 20 |70 de marg 20 6 d'atrr. 20 |13 dabr. 20
bobblblbhblbbblblbblbhbbbbbbbbbl
) 200%
[~ Téemicos
: : 175%
QOperarios
Pedn 2 126%
-4 Cuadrila de estructuristas
Gastos O
Magquinaria y medios TE%
Material construccidn
50%
5%
h 0%

Figura 58.
Histograma de recursos

° Charts: muestra diversos graficos para presentar la informacion del
proyecto (Cost, Actual Cost, Fixed Cost, Remaining Cost, etc.). Esta infor-
macion puede mostrarse en formato de linea o de histograma, y acumulada
o no. Véase ejemplo en la figura 59.

wes @ ~— Type Effort... Total Slacky| 12 dioct. 20 26 d'oct. 20 |2 de now. 20 3 de nov. 20 16 de nov. 2(
bbb bbb bbbbbbbbbbbbbbbhE
11 41 Eesbroce y limpieza del terreno|Fixed Work 0 da: on 1;Retroexcavadora:Peon 2[50%]
12 42 Excavacion de zapatas Fixed Work 0 da: troexcavadora:Peon 2[50%]
13 |43 Fin de movimiento de tierFixed Work 0da
4 5 [l Cimentacidn Fixed Units 0 day| 7
5 51 Encofrado de zapatas  Fixed Work 0 dar 21dial:Enc
6 52 Hormigdn de limpieza  Fixed Work da Pegmr i teomr HH-150 bla
17 5.3 Colocacion de separadonFixed Work * Pt hPetr fSeparad
18 |5.4 Hormigonado Fixed Units O Peiy 2[20%]
19 55 B Fraguado hormigdn (temFixed Duration O
20 56 [x] Fin de Cimentacién Fixed Units O 1711
€ - € >
o =5 No Filter " Elmiiate ~ 19 dioct. 20 26 doct. 20 |2 de nov, 20 |9 de nav, 20 |16 de now, 2¢
polbhbbblblbbbbbbbbbbbbbbblbbbbbblbhbblhl
) [[] Histogram
EQUIPO TECNICO 2750
MANO DE CBRA Oywork @) cost
-
z Pedn 2 2500
-# Cuadrila de estructuristas
GASTOS £250
MAQUINARIA ¥ MEDIOS Actual Fixed Cost

Figura 59.
Grafico de coste acumulado para un recurso (Pedn 1) asignado a una tarea
(Desbroce y limpieza del terreno)

. q Task Usage: muestra el uso de las tareas con el desglose de los recursos
asignados a cada una de ellas y su distribucion temporal en horas (cada dos
horas). Esta subvista resulta util combinada con la vista Gantt.
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. @ Resource usage: muestra el uso de los recursos con el desglose de las
tareas vinculadas a cada uno de ellos y el tiempo invertido en cada tarea.
Esta subvista resulta util combinada con la vista Gantt.

. |:| No sub-window: suprime cualquier subvista que se esté visualizando.

8.4. Filtros

Por ultimo, el menu Sub-view ofrece la posibilidad de filtrar la visualizacion de
tareas seglin su tipo. Desde la vista Gantt, pueden seleccionarse diferentes opcio-
nes para filtrar, clasificar y/o agrupar tareas, como se muestra en la figura 60.

Critical tasks

MNormal tasks

Mo Filter

Cost overbudget tasks

In-progress tasks
Incomplete tasks
Late foverbudget tasks

Gestion de proyectos con ProjectLibre™
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Figura 60.
Opciones de filtro, clasificacion y agrupacion

72

Mo Filter v
No Sorting ~
MNo Group v
Complete fincomplete

Critical

Duration

Critical then duration
Resource Names
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9. Nivelacion del proyecto

El proceso de asignacion de los recursos del proyecto a las tareas conlleva, en
muchas ocasiones, la pérdida de control sobre la carga de trabajo finalmente asig-
nada a cada recurso. Una de las funciones mas importantes de la Project Manager
es la supervision de estas asignaciones y su correcta nivelacion para optimizar el
proyecto y garantizar su realizacion en plazo de tiempo y en coste.

Los desajustes en la asignacion de recursos dan lugar a dos situaciones:

e Sobreasignaciones: cuando el recurso tiene sobrecarga de trabajo; por ejem-
plo, por verse implicado en varias tareas al mismo tiempo o por tener asig-
nada una carga de trabajo por encima de su capacidad maxima disponible
(Max. Units). En este caso, serd necesario reducir la carga de trabajo del
recurso.

e [nfraasignaciones: cuando el recurso trabaja por debajo de su capacidad. En
este caso, se podrd aumentar la carga de trabajo de dicho recurso.

Tras el proceso de asignacion de los recursos a las tareas, se debera revisar si
existen desajustes y realizar la optimizacion del proyecto. Para ello, en primer
lugar, serd necesario identificar las sobreasignaciones e infraasignaciones y, en
segundo, resolverlas, es decir, nivelar el proyecto.

La nivelacion del proyecto siempre debe aspirar a que los consumos de los di-
ferentes tipos de recursos durante el periodo de ejecucion de proyecto sean lo mas
uniformes posible. La situacion 6ptima, a la que en la mayor parte de los casos
no se podra llegar, sera aquella en la que el consumo de cada uno de los recursos
coincide exactamente con su capacidad maxima, en cada uno de los periodos de
tiempo en los que se ejecuta el proyecto.

9.1. Identificacion de sobreasignaciones e infraasignaciones

Existen varias vistas interesantes para identificar las sobreasignaciones e infra-
signaciones de los recursos del proyecto. Se explica a continuacion cada una de
ellas. Segun el nivel de detalle con que se desee identificar el recurso y el tipo
de accion de nivelacion, puede ser mas conveniente emplear una u otra. Queda a
eleccion del usuario seleccionar aquella mas conveniente en cada caso.
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1)

Vista combinada Gantt - Histograma de recursos. Permite dividir el panel
del ProjectLibre en dos subpaneles, uno superior donde se visualiza la Tabla
de tareas y el Gantt y, uno inferior, donde se visualiza el Histograma de los
recursos. Para acceder a esta vista, desde la vista Tabla de tareas y Gantt ,
hay que clicar en la subvista Histograma , boton situado en la parte superior
derecha (véase figura 61). En el Histograma, la asignacion de recursos se
identifica de la siguiente manera:

* M Clic en la tarea en la que se desee comprobar los desajustes, desde la
Tabla de tareas.

. E En el listado de recursos del proyecto (subvista Histograma), el simbolo
@ indica los recursos que estan asignados a la tarea seleccionada. Al cli-
car sobre cada recurso del listado, se muestra el histograma de asignacion
de cada uno de ellos (E). Desplazando la barra inferior, se puede abarcar
la visibilidad de todo el calendario del proyecto.

— Esta vista resulta util para identificar, en general, qué recursos y cuando
estan sobreasignados.
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74

Marta Braulio Gonzalo y Valeria Ibafiez Forés
DOI: http://dx.doi.org/10.6035/Sapiential 80



2) Vista combinada Uso de recursos - Histograma. Permite dividir el panel del
ProjectLibre en dos paneles, uno superior donde se visualiza el uso de recur-
sos con la vista detallada en el calendario (hora a hora y en qué tareas) y, uno
inferior, donde se visualiza el Histograma. Para acceder a esta vista, desde la
vista Uso de recursos , es necesario clicar en la subvista Histograma (véase
figura 62). La asignacion de recursos se identifica de la siguiente manera:

zontal en el Histograma y el calendario.

i Seleccionar el recurso a analizar en la subvista.
8 Identificar las sobreasignaciones desplazdndose mediante la barra hori-

Las sobreasignaciones se pueden asociar a las tareas en la vista Uso

de tareas y también ver cudntas horas invierte el recurso en cada una de
ellas. La nivelacion puede realizarse modificando las horas en las celdas,
directamente. ProjectLibre reajustard y distribuird las horas restantes de
acuerdo con la programacion de la tarea y el calendario.

ﬂ Muestra las tareas en las que los recursos estan involucrados.

— Esta vista resulta util para identificar, qué recursos, cuando y en qué ta-
reas estan sobreasignados.
— Haciendo zoom en el Gantt, se puede llegar a nivel de detalle horario
(cada dos horas).
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Vista combinada Uso de recursos-Histograma

Figura 62.
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3) Vista combinada Gantt — Uso de recursos. Permite dividir el panel del
ProjectLibre en dos paneles, uno superior donde se visualiza el Gantt y, uno
inferior, donde se visualiza el Uso de los recursos. Para acceder a esta vista,
desde la vista Tabla de tareas y Gantt , basta clicar en la subvista Uso de
recursos # (véase figura 63). La asignacion de recursos se identifica de la
siguiente manera:

o I\ Seleccionar la tarea a analizar en la Tabla de tareas.

* [ Acercar la vista del Gantt a la tarea mediante el comando Scroll To
Task.

* [ En la subvista de tareas se visualizan los recursos asignados a la tarea 'y
en | las horas.

— Esta vista resulta 1til, una vez se han identificado los recursos sobreasig-
nados, para ver en qué tareas y cudntas horas estan asignados, y realizar
los ajustes oportunos.
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Figura 63.
Vista combinada Gantt-Uso de recursos

Las combinaciones de vistas aqui comentadas son una recomendacién para fa-
cilitar el proceso de nivelacion, sin embargo, pueden existir otras combinaciones
también interesantes, segun la accion de nivelacion que se desee implementar.

9.2. Nivelacion del proyecto

Identificados aquellos recursos que estan sobreasignados, se debe proceder al
ajuste de su carga de trabajo para la optimizacion y nivelacion del proyecto.
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Como punto de partida de la nivelacion, cabe indicar que se deben consultar
en primer lugar los datos globales del proyecto, desde el menu Informacion del
Proyecto (Information Project > Statistics), en términos de duracion total, carga de
trabajo total y coste del mismo (véase figura 7). Ello ayudara a no perder de vista
el estado inicial del proyecto y contribuird a la toma de decisiones.

En unos casos, la prioridad a la hora de nivelar el proyecto puede ser el no
ampliar su duracion, mientras que, en otros, no aumentar las horas de trabajo o el
coste. Dependera del alcance y las restricciones de cada proyecto.

La nivelacion de recursos en ProjectLibre no es automatica, sino que la realiza
de forma manual el usuario, de manera que sera este quien tome las decisiones
oportunas, teniendo pleno control sobre sus acciones. Hay que decir que la nive-
lacion es uno de los procesos mas importantes durante la planificacion y progra-
macion de un proyecto y es, a su vez, un trabajo laborioso y complejo, en muchos
casos. No hay una unica forma de nivelar un proyecto, sino que existen multiples
opciones, estrategias y combinaciones de todas ellas. La Project Manager tomara
las decisiones oportunas segun su criterio y experiencia.

Se citan a continuacion algunas de las estrategias mas relevantes que pueden
llevarse a cabo para nivelar el proyecto:

e Desplazar tareas temporalmente para evitar solapes en los que intervengan
los mismos recursos.

Incrementar la capacidad de los recursos.

Sustituir recursos sobreasignados por aquellos infraasignados.
Modificar las unidades de asignacion.

Aumentar la duracion de tareas.

Ajustar las relaciones de dependencia y/o restricciones.

Ajustar el calendario del proyecto para ampliar dias y horas laborables.
Ajustar el calendario de los recursos.

Dividir tareas, para evitar solapes entre tareas.

Suprimir recursos que sean prescindibles.

Etc.

Se deberd tener en cuenta la repercusion de cada una de estas acciones y como
afecta, en términos globales, al proyecto. Especialmente, en aquellas acciones que
implican alargar los tiempos, se debera considerar la holgura total (H,) y la hol-
gura libre (H,) de las tareas involucradas, si no se desea alargar la duracion del
proyecto, posponiendo su fecha de fin (véase apartado 4.9).

Es conveniente, por tanto, visualizar las holguras libre y total en la Tabla de ta-
reas, insertando dichas columnas (Free Slack'y Total Slack) o, bien, desde la Tabla
de tareas, seleccionando la opcion de vista Schedule (cpu).
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10. Seguimiento

Una vez planificado y programado el proyecto, ProjectLibre permite realizar su
seguimiento real en base a lo realmente ejecutado, introduciendo las fechas de ini-
cio y fin reales, asi como el porcentaje de trabajo real ejecutado. Hay que tener en
cuenta que, durante el transcurso de los proyectos, puede ser habitual la aparicion
de imprevistos que originen retrasos inesperados, desfases de costos y cambios en
los recursos. Si esta informacion se mantiene actualizada en tiempo real, el Project
Manager podré anticiparse a los problemas que puedan afectar al éxito del proyec-
to y actuar para evitar que ocurran 0 minimizar sus consecuencias.

Previamente a introducir la informacion para realizar el seguimiento del proyec-
to, es necesario establecer una linea base y una fecha de estado. A continuacion, en
los siguientes apartados, se exponen los pasos a seguir para realizar el seguimiento
completo del proyecto en ProjectLibre, incluyendo la creacion de lineas base e
introduccion de la fecha de estado.

En primer lugar, se esclarecen los términos que ProjectLibre emplea para refe-
rirse a los estados de previsto, real y en progreso:

e Baseline (linea base = previsto inicialmente): fechas, trabajo, duracion y
costo planificados (o previstos) inicialmente.

e JWork, Cost, Duration (real final): fechas, trabajo, duracion y costo que indi-
can la situacion final futura del proyecto en funcion de su avance real.

e Actual (real en progreso): fechas, trabajo, duracion y costo terminados o en
progreso, segun el avance del proyecto.

e Remaining (real remanente): trabajo, duracion y costo restante real que queda
por completarse hasta finalizar el proyecto (p. €j.: Remaining Work = Work —
Actual Work. Véase ejemplo 16).
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10.1. Lineas base

La linea base (Baseline) es el reflejo de lo que el planificador del proyecto
ha estimado inicialmente y tiene como objetivo poder comparar la planificacion
inicial y aquello que realmente se ha ejecutado, en un momento determinado en
el tiempo. La linea base es, pues, como una captura o imagen fija de la informa-
cion del proyecto planificado en una fecha determinada y sirve como estado de
comparacion.

Por ello, es muy importante que sea el primer paso a realizar previamente a
iniciar el seguimiento del proyecto, para no perder de vista la informacion de par-
tida, inicialmente planificada.

Para establecer la linea base, se accede al menu File > Save Baseline y, como
se observa en la figura 65, accediendo a dicho menu se pueden establecer hasta 11
lineas base diferentes.
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Figura 65.

Guardar linea base y visualizacion de la misma

La linea base puede generarse del proyecto completo o solamente de ciertas
tareas, seleccionandolas previamente a acceder y marcar dicha opcion en el mena
anterior (Selected Tasks).

Al guardar una linea base, aparece una linea de color diferente debajo de las
barras del Gantt.

Para eliminar una linea base, se accede al menu File > Clear Baseline.

Cuando se accede a la pestaia Statistics en el menu Project Information, se
observa que los datos relacionados con la duracion, el trabajo y el coste ya quedan
reflejados para la linea base una vez esta ha sido guardada. Estos datos corres-
ponden a lo previsto o planificado inicialmente para el proyecto (justo antes de
efectuar el seguimiento).

10.2. Fecha de estado

La fecha de estado es la fecha en la que se desea controlar la evolucion del
proyecto, es decir, la fecha hasta la que se desean introducir los datos reales de
desarrollo del proyecto, y se establece desde el menu File > Project Information
> Status Date. En el grafico Gantt, dicha fecha queda representada con una linea
vertical de color verde en trazo discontinuo.

10.3. Progreso del proyecto

El seguimiento refleja dos aspectos sobre la evolucion del proyecto:

A. Cambios o variaciones producidas en las tareas debidas a posibles impre-
vistos: fechas reales de inicio y fin, o duracion, trabajo y coste real final de
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las tareas desarrolladas. Estas variaciones deben introducirse en los cam-
pos correspondientes, Start, Finish, Duration o Work, en la Tabla de tareas
(siempre tras haber guardado la Baseline, para no perder su referencia).

B. Avance real del proyecto en una fecha de estado, en términos de porcentaje,
trabajo o duracién completados. El avance debe introducirse en el campo
porcentaje (Percent completed) o en los campos Actual Duration o Actual
Work.

Para introducir el progreso de las tareas que integran el proyecto conviene vi-
sualizar la vista Gantt de seguimiento, que ayudara a identificar puntos que difie-
ren del plan inicial previsto. Para ello, desde la Tabla de tareas, se puede visualizar
la informacion propia del seguimiento mediante las columnas propias de la Tabla
de seguimiento o Tracking, pulsando clic derecho del cursor en la primera celda
superior izquierda (figura 66) y seleccionando 7racking del menu desplegable.

-
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Figura 66.
Vista Tabla de seguimiento

10.3.1. Actualizacion de las tareas

Las tareas deben actualizarse respetando su orden cronologico, es decir, no
actualizando una tarea antes que su predecesora.

Los datos reales que pueden introducirse en el seguimiento de un proyecto son:

e Fecha real de inicio y fin de las tareas.
e Porcentaje completado de las tareas.
e Duracion real de la tarea.
e Trabajo real de la tarea.
e El coste real no puede modificarse manualmente, sino que es resultado del
calculo automatico.
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Esta informacion puede introducirse de dos formas diferentes:

e desde la propia Tabla de seguimiento, rellenando los campos de las colum-
nas correspondientes, o bien,

e seleccionando la tarea, accediendo al mentl 7ask > Update y modifican-
do los valores deseados (figura 67). Repetir este proceso para cada tarea a

actualizar.

ant Update Tasks >
Tasks: 2

Mame: |Tarea Al |
Percent Complete: | 67% -+ Duration: 3days |
Start: '15/05/20 08:00 | | Finish: 19f05/20 17:00 |

Actuzl Duration: 2 days

| Remaining Duration: | 1 day |

Actual Start: 15/05/20 08:00 | = | Actual Finish: | [=]
Type: FixedUnits |
Close Help
Figura 67.

Actualizar el seguimiento de las tareas
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10.3.2. Actualizacion del proyecto completo

También puede actualizarse el proyecto completo desde File > Update. En este
caso, la actualizacion no va asociada a una tarea concreta, sino al proyecto o a un
grupo de tareas seleccionadas de manera previa, cuando se accede al menu.

La figura 69 muestra las opciones que da el ment. Estas son:

e Actualizar el trabajo como completado en una fecha dada:

— Ajustar el porcentaje completado en una fecha dada: en dicha fecha las ta-
reas se completaran hasta el porcentaje, de 0 a 100 %, que le corresponda
a cada una.

— Ajustar y completar al 100 % solamente las tareas que finalizan por com-
pleto y con anterioridad a la fecha dada.

e Reprogramar el trabajo restante tras una fecha dada.

&% Update Project bt

(@  Update work as complete through 05/05/20 -
(@) Adjust percent complete according to the date

(O) Only adjust (and complete) tasks that finish by the date

() Reschedule remaining work after 05/05/20 -

For:

(®) Entire Praject

() Selected Tasks

CK Cancel Help

Figura 69.
Actualizar el proyecto completo

10.4. Visualizacion del seguimiento

Cuando se ha guardado la Baseline, al acceder al menu File > Project
Information > Statistics, se puede observar la variacion de los datos globales del
proyecto en términos de fechas, duracion, trabajo y coste, para los estados de
Baseline (previsto inicialmente), real final, real en progreso y remanente.
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Remaining Cost: €4231,25

Figura 70.

Estadisticas globales del proyecto en seguimiento

También se puede obtener la informacion global del proyecto:

e En la propia Tabla de seguimiento, en la tarea resumen del proyecto (prime-

ra fila).

e Desde File > Projects Dialog, insertando las columnas correspondientes que

se deseen visualizar.

O El porcentaje % completado del proyecto en términos globales se puede
= visualizar desde la tarea resumen del proyecto o desde File > Project ¢

insertando la columna % completado.
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11. Informes

Los informes del proyecto permiten extraer la informacion y presentarla de forma
adecuada para su comunicacion. Su objetivo es facilitar el analisis de los resulta-
dos parciales o totales del proyecto e identificar el estado del mismo para tomar
decisiones e implementar acciones que corrijan o mejoren los posibles puntos cri-
ticos que podrian afectar al correcto desarrollo del trabajo.

Los informes permiten, pues, analizar y evaluar el ciclo de vida completo de
un proyecto.

Existen seis elementos fundamentales que conforman los informes, a los que se
accede desde los ments indicados en la figura 71.

GANTT INFORMES REPORTS GRAFICOS CHARTS

13 dabr. 20 [20 dabr. 20 [27 dabr 20
bbb bbb bbb bbb pbbbhh

Freeg e TM 20128
e =i l“1
e, = 1

2704

Quién hace Qué
Who Does What

Informacién de Tareas
Task information

Informacién de Recursos
Resource information

Detalles del proyecto
Project details

S
=la

File Task Resource View

[Projetibre. ) 22—

twork RBS [=] Projects || wiA Histogram Resource Usage
Resource Usage | [] Report Charts ] No sub window
Gantt | B Task Usage || Resources 53 Task Usage
kb Open | ©Close | f= print \ Task views Resource views Other views Sub-views
O New O Preview
e M saveas . pOF ) <Eepcrt: Project Details . )
Fie Bk H@o Wk m: | Do &igfees -
Figura 71.

Tipos de informes

En los siguientes apartados se detalla como se obtiene el grafico Gantt y cada
uno de los tipos de informes y gréficos.

11.1. Diagrama de Gantt

Para previsualizar el diagrama de Gantt, se accede al menu File > Preview y
se formatea la vista segun lo deseado. La previsualizacion permite las siguientes
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opciones: imprimir en impresora o formato PDF, orientacion vertical u horizontal de
la pagina, configurar los margenes, imprimir la Tabla de tareas y/o el diagrama
de Gantt y escalar la pagina mediante el % o el nimero de paginas.

Hay que tener en cuenta que la impresion del Gantt depende de lo que se esté
visualizando en la interfaz del programa, en cuanto a columnas, opciones de for-
mato de las barras del Gantt y zoom se refiere.

Lo mas conveniente para obtener una buena optimizacion del grafico Gantt,
es tener las siguientes opciones activadas en el menu de previsualizacion (véase
figura 72):

e Imprimir como ppf. Una vez guardado en ppF el Gantt, desde el propio fi-
chero ppF, se puede guardar como imagen. El formato *.tiff ofrece mejor
resolucion de imagen que el *.jpg.

¢ Orientacion horizontal.

e Tamafio A4 o A3 (si el diagrama abarca un calendario muy amplio).

e En Diagrams, marcar tanto Spreadsheet (para mostrar la Tabla de tareas)
como Gantt.

— Si se desea potenciar la informacion del grafico Gantt frente a la Tabla
de tareas, conviene visualizar inicamente el nombre de las tareas en la
Tabla de tareas. Ello se consigue rapidamente seleccionando en la Tabla
de tareas la opcion Name/Nombre.

e Escalar el % de manera que todo el Gantt se visualice en una sola pagina.

] Print preview - o x
¢ ravh BAE BT

Printers.
Adobe PDF v

T T Orientation

Narv:

Exnmcs e nams  dm. TG gaw. 20 [ dam 0 | EEPE
olofofofoofofofofofofoofofoln fofofo fofefofofolo fofoln [olofofo [efofoloTo oo lo]o o

Landscape <

PROYECTO NAVE INDUSTRIAL

FReuniones de 8 D.F.
Reitn 1

Width (mm): |210,0

P
Firmma e et chs Reglantens Ingesiers;Argsiteccs Tecsice: Jefe de shra:Peda L Peca LiCafe[1]
| . " s .

Rewitn 2

Cafe4]

Tewion 3

1
| Bes canely] Height (mm): [297,0
Rt 3 = : .
Rewsitn 5
ST r— —
Destrore y limpieza de terrem [

Ble|e| afo|n|efuwl]-

[ Preject Mussger:Tngeaiers; Arguirects

Margins
Left(mm)  Right (mm)
Dicavectn o saptas 10,0 10,0

B e

LiCimentacion Top (mm)  Bottom (mm)
B immm 0o |lmo

P g i s

Cheesin & ey o e = : _—

e "

P o o o] Fymeroneny B spreachest
Fopet o s o e

T & Covetacin . Gantt

=1

E1E

HE

e

Scaling

@ Scale to:
100% -3 width
100% = | height
Constrain
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(Fit to:
. - — 2 % | pages wide
e == 1 2| pages high
Make Default
Figura 72.
Previsualizacion del diagrama Gantt
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11.2. Informes

Detalles del proyecto

Este informe muestra la informacién general del proyecto en relacion a fechas
de inicio y fin (prevista y real) y duracion, trabajo y costes (previsto, real, % com-
pletado y variacion). Véase figura 73.

El informe se puede guardar en diversos formatos, pulsando el icono Save den-
tro del menu Report.

Report: |Project Details ~

H&|G [l

Ejecucion de nave industrial

Dates

Start 26/03/20 08:00 Finish D04/05/20 18:00
Basalina Start 26/03/20 09:00 Basalina Finish 2770420 11:00
Actual Start 26/03/20 09:00 Actual Finish

Duration

Schadulad 24 days Ramaining 24 days
Basalina 19,25 days Actual 0days

Parcant Complate Ta%

Schadulad 486 6 hours Ramaining 105 hours
Basaling 422 hours Actual 3818 hours

Schadulad £9807 35 Reamaining E304500
Basaling €90258 00 Actual E6559.35
Varianca €97
Notas
Actividad 2. Facha da finalizacion dal proyecto: 22/04 w
L4 >
Page 1 of 1
Figura 73.

Informe: Detalles del proyecto

Informacion de los recursos

Al desplazarse por el ment desplegable Reports, se accede al informe Resource
Information que, a su vez, permite presentar diversa informacién, con diversas op-
ciones, en un segundo menu desplegable (véase figura 74), como es, por ejemplo,
el valor ganado y sus indices:
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BCWS: Budgeted Cost of Work Scheduled
BCWP: Budgeted Cost of Work Performed
ACWP: Actual Cost of Work Performed
CV: Cost Variance

SV: Schedule Variance

EAC: Estimate at Completion

Report: Resource Information - | Columns: |Earned Value ~

H&|S W<

w1 OEE &R ses%

Resource Information

D
1 Téomoos 399200 399200 392,00 3000 3000 399200 oAz
2 Projac Maager $15000 $150,00 § 150,00 §000 3000 $150,00 §180
3 Ingenien 32500 332500 § 32500 3000 3000 332500 F325
4 Amyuitecta Téonicn 37500 327500 327500 3000 3000 327500 3275
5 e e b 324200 3280 324200 3000 3000 324200 3242
L] Opemrios 3205352 F2457 59 3369380 31.23601 F40407 F3EA380 § a7
7 Padn 1 3136192 3 182 85 218,20 3 55455 326473 218120 3 16294
& Padin 2 389160 383093 3151240 3 68147 31533 3151240 3830
9 Cuackila de estucturistas 3000 30,00 30,00 3000 3000 3000 31300
10 Gastas 3000 30,00 311,00 3 11,00 3000 3000 31073
i1 Tarsa licmnca atvas 3000 30,00 30,00 3000 3000 3000 31000
12 Dieta por desplaramienta 3000 30,00 30,00 3000 3000 3000 350
13 o 3000 30,00 311,00 3 11,00 3000 3000 323
14 Magquinada y medicas 46400 §1E2 5 3 532,00 $1.10051 3122851 370300 3173
15 Retmoexcavadam 46400 3417 51 3 575,00 3 157,49 3 4649 363903 F454
16 Encafrada 3000 3127500 317,00 $1.25800 3127500 31700 31275
17 Material construcadn 3000 313025 312875 34950 3133125 3128175 3 1468
18 Hormigan HL- 150 bianda TM 20 3000 30,00 30,00 3000 3000 3000 3137
19 Hormigan H-25 blanda TM 20 its 3000 381250 F&2.50 3000 381250 381250 a2
20 hoem BN S 3000 346375 3 488,75 3000 346875 346875 3458
21 Sepamdomsde pldsion 3000 35000 30,50 34950 35000 3050 350
22 3000 30,00 30,00 3000 3000 3000 30
23 Recurn fclicn Sempa 3000 30,00 30,00 3000 3000 3000 30
3701904 3 1234@ $13.140,70 19401 3592785 F 1329373 318080

£

Page 1 of 1

Figura 74.
Informe: Informacién de los recursos con valor ganado

Informacion de las tareas

En el caso de las tareas, ocurre lo mismo que con los recursos, los dos menus
desplegables permiten ajustar qué informacion se desea mostrar. En este caso, la
figura 75 presenta el informe de la variacion entre lo previsto y el seguimiento real,
para cada una de las tareas de un proyecto.
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Report: | Task Information | Columns:

HSG W 4 M O 0N & S 50% ~

el
Task Information
Finish Baseline Starl Basaline Finish Start Offset Finis h Offs ot}
BN 0E0D OB 1200 HE0AE0 M0 TR0
Pemisos OO0 0e W ZEEI 1100 BEOBE0 B0 B0 110 0 oS
3 Fima dd Aca de Replantoo ANCAZ0 00D IR Da 00 RS0 B 00 A0 1200 0 days.
4 Riaunionas o la OF. OO0 11D 10D 1000 TEOIE0 1100 21042010000 0 oS 0 days
5 Raunin 1 B0 1D RN 1300 ZE0RE0 MO0 B0 0 days 0 days
& Raunicn 2 OO0 080 NS 1000 VO3S0 B0 FOFZ0 1000 0 oS 0 days
T Raunin 3 D20 000 OENH/ZD 1000 OEC4E0 et DEACZ0 10000 0 days 0 days
-3 Raunicn 4 HZ0 080 140D 1000 ATHE0 CE0D HCHZ0 10000 0 oS 0 days
9 Raunin 5 A0 080 2D 1000 20420 B0 A0 10000 0 days 0 days
10 Mecrdmlanio o SeiTas ANOFI0 e 0 G 1700 SOOGS0 0B 00 HIOZ0 0848 0 oS 27T days
11 Dusbrocey limd c2a g temens ANOAZ0 0800 SN/ e 42 JO0RE0 B 00 DEACZ0 0042 0 days 0 days
1z Ercraddn & 2apdas QB0 0 4E OETME0 EdE HIOZ0 0848 0 oS 27T days
13 Fim e Mo anto o Somas. B0 T 140420 (EdS HAOAZ0 00428 27T days 27T aayn
14 Cimengadcn A4THE0 CEdE 4011 2775 days 4,75 days
15 Encofradn it 2apatas 140420 (EdS 20004 27T days 1775 days
18 Homign & Inpiaa AETHE0 CEdE I 1448 1,775 days. 6375 days
AT doaddn & separatons sobie BT S0 1500 2420110 2ETE days 275 days
12 Homuigonado TO4I0 08 ZV4E0 1100 ZO40110 375 days 375 cays
19 Fraguacc homuigan { femps B0 0e0m ZEA4E0 MO0 T4 1775 days. 1775 days
o Fraguaco homuigdnlimg@a 21042017 DT AETE0 1500 B0 150 15235 cays. 1525 days
3l Fim e Cimentud dn EOEZ0 0000 DD 1200 ZT04E0 100 T4 375 days 475 days
W
£ >
Page 1 of 1

Figura 75.
Informe: Informacién de las tareas con variacion en la programacion

Quién hace qué

Este informe permite visualizar la responsabilidad de cada uno de los recursos
con respecto al cumplimiento de las tareas a las que est4 asignado (véase figura
76). El segundo menu desplegable, Columns, ofrece diferentes opciones de visua-
lizacion de la informacion.
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Report: | Who Does What | Columns: |Basic Report -

== DEIN & & s -

Who Does What

Resource ID Resource

2 Project Manager
a Reundn § 1 hraur 100% Odays AR 2104720 10:00
] Reridn 1 1 haur 100%: Odays 260320 1100 2603/20 12200
a Reunicn £ 1 howr 100%: Odays 1404720 0300 1404720 10:00
7 Rewnidn 3 1 haur 100%: Odays 060420 18:00 DGI0420 10:00
] Reundn 2 1 hraur 100% Odays 10320 (800 0320 10:00

5 hours
3 Ingenies
[ sk T Sk ok AssigomentUnits Assigment —————Stan ————Finian]
] Reunidn § 1 haur 100%: Odays 210420 1900 21404720 10:00
] Reunidn 2 1 haur 100%: Odays 3140320 0900 3140320 10:00
2 Permisas 2 hours 100%: Odays 260320 1800 26003/20 11:00
a Reunicn £ 1 howr 100%: Odays 1404720 0300 1404720 10:00
] Reridn 1 1 haur 100%: Odays 260320 1100 2603/20 12200
7 Rewnidn 3 1 haur 100%: Odays 060420 18:00 DGI0420 10:00
3 Fioma del Acta de Replamea & hours 100%: Odays 300320 0900 30/03/20 16:00
13 hours

a Arquitecto Téenico
- Wiork —Assignment Units Assignment ——__Sai ______Finish]
] Reunidn § 1 haur 100%: Odays 210420 1900 21404720 10:00
7 Reunidn 3 1 haur 100%: Odays 060420 1800 D60420 10:00
] Reridn 1 1 haur 100%: Odays 260320 1100 2603/20 12200
a Reunicn £ 1 howr 100%: Odays 1404720 0300 1404720 10:00

Page 1
W
£ >
Page 1 of 5

Informe: Quién hace qué

11.3. Graficos de resultados

La subvista Charts muestra diversos graficos para presentar informaci-
on del proyecto en términos de trabajo y coste (Cost, Actual Cost, Fixed Cost,
Remaining Cost, Baselines, etc. y las homoélogas para Work). Esta informacion
puede mostrarse en formato linea o histograma y acumulada o no, segtin las opci-
ones seleccionadas.

La informacion se puede mostrar para una tarea, seleccionandola en la Tabla
de tareas, o para varias de ellas, seleccionandolas con la tecla cTrRL. Si se quiere
mostrar la informacion para el proyecto completo, deberan seleccionarse todas
las tareas (puede hacerse rapidamente haciendo clic en la celda de union de filas
y columnas).

Ademas, mediante el filtro de recursos, pueden seleccionarse los recursos para
los que se desea mostrar especificamente la informacion.

La opcion de visualizar el grafico mediante una linea (no Histograma) permite
seleccionar mas de un campo simultaneamente con la tecla cTrL, de manera que el
grafico muestra las lineas superpuestas.

Haciendo uso de los graficos se pueden generar diferentes Curvas «S».
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Figura 77.

Curva «S» del trabajo acumulado en relacion a la linea base
(trabajo planificado inicialmente)

Cabe indicar que la informacion de la Tabla de tareas proporcionada por
ProjectLibre puede copiarse en una hoja de calculo para tratarla y generar

graficos que den una informacion mas personalizada y detallada del

proyecto.
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12. Actividades propuestas

Con el objetivo de poner en practica los contenidos expuestos, esta tltima seccion pro-
pone un conjunto de actividades para desarrollar un caso de aplicacion. Las activida-
des plantean la secuencia logica para la gestion de un proyecto sencillo de ejecucion de
una nave industrial, en algunas de sus fases. Dicha secuencia atiende a los procesos
de: planificacion, programacion, nivelacion, seguimiento y extraccion de informes.

Actividad 1: Planificacion

e Crear un nuevo proyecto llamado «Ejecucion de nave industrialy, progra-
mado desde la fecha de inicio y que esta quede fijada en el proximo jueves
del calendario.

e Configurar los pardmetros de duracion para el calculo de la programacion
de acuerdo con lo siguiente:

— Jornada laboral: 8 horas/dia.
— Horas por semana: 40 horas
— Dias laborables al mes: 20 dias

e Generar el listado de tareas mostrado en la tabla 8, correctamente agrupadas
en tareas resumen. Seguidamente, introducir las duraciones estimadas, crear
las dependencias entre las tareas y las restricciones e introducir la EDT/WBs.

Tabla 8. Actividad 1: listado de tareas y descriptores.

Nombre Duraciéon Dependencias Observaciones

Proyecto nave

industrial
1 Permisos 0 dias 1. dia
(hito)
2 Firma del Acta de 0 dias Empieza 1.&
Replanteo (hito) lunes
3 Reuniones de Ajustar n.° de
la Direccion reuniones a la
Facultativa duracion del
proyecto
Gestion de proyectos con ProjectLibre™ 95 Marta Braulio Gonzalo y Valeria Ibafiez Forés
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Dependencias ‘ Observaciones

e Generar el listado de recursos indicados en la tabla 9 y sus costos asociados.
Agrupar los recursos segun los grupos indicados.
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Ademas, hay que considerar lo siguiente:

* ElPeodn 1 tiene previsto un aumento de sueldo del 10 %, que se hara efectivo
a partir del mes siguiente al inicio del proyecto.

» FElPeon 2 tiene prevista una reduccion a media jornada a partir de la segunda
quincena del mes siguiente al inicio del proyecto.

Actividad 2: Programacion

o Configurar el calendario del proyecto, llamado «Obra», de acuerdo con las
siguientes condiciones:

— Laborable de lunes a viernes de 9:00 a 14:00 h y de 15:00 a 18:00 h.
— Dias festivos: 1 y 6 de enero; 19 de marzo; 1 de mayo; 24 y 29 de junio;
15 de agosto; 9 y 12 de octubre; 1 de noviembre; 6, 8 y 25 de diciembre.

o Asignar el calendario «Obray al proyecto.
e Incluir las siguientes consideraciones:

— Resulta conveniente realizar las tareas de hormigonado de forma con-
tinuada, por lo que, si alguna de ellas queda interrumpida por el fin de
semana, es aconsejable desplazar su comienzo al lunes siguiente.

— La tarea «Fraguado de hormigén» implica una duracion de cinco dias
naturales, que han de computar en tiempo transcurrido. Ajustar el calen-
dario de dicha tarea para que su programacion sea correcta.

— Ajustar el nimero de reuniones periddicas a la duracion del proyecto.

o Asignar los recursos a las tareas de acuerdo con lo indicado en la tabla 10.
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Tabla 10. Actividad 2: Asignacion de recursos a tareas.

Nombre
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Actividad 3: Nivelacion y optimizacion

Visualizar el diagrama de red pErT (Network) del proyecto.

Visualizar el diagrama de flujo de la £p7/was.

Visualizar el diagrama de flujo de la £pr/Rrss.

Visualizar los histogramas de los recursos e identificar las sobreasignacio-
nes e infraasignaciones. Es recomendable realizar un trabajo de andlisis en
un documento de texto y elaborar una tabla, cuyo modelo se adjunta en la
tabla 11, para estudiar cada caso y poder plantear, posteriormente, las accio-
nes de nivelacion pertinentes en cada caso.

Tabla 11. Actividad 3: Anélisis de sobreasignaciones e infraasignaciones.

Recurso Fecha Tarea/s Horas de sobre/ Observaciones

infra-asignacion

e Consultar y guardar la informacion global del proyecto, en términos de fe-
chas de inicio y fin, duracion, trabajo y costo, desde el menu Statistics.

e Tomar decisiones sobre las acciones de nivelacion necesarias para corregir
las sobreasignaciones y/o infraasignaciones, € implementarlas para optimi-
zar el proyecto.

e Consultar de nuevo la informacion global del proyecto y valorar la optimi-
zacion obtenida tras el proceso de nivelacion.

Actividad 4: Seguimiento

Se pide introducir el seguimiento del proyecto y evaluar su estado, en térmi-
nos de porcentaje completado, duracién, trabajo y coste, en las dos situaciones
siguientes:

o El Project Manager efectiia un primer control del avance proyecto el tercer
viernes desde el inicio del mismo y comprueba que todas las tareas se han
ejecutado conforme a la programacion inicial.

e El quinto viernes desde el inicio del proyecto, el Project Manager efectua
un segundo control y observa que, tras algunos imprevistos ocurridos duran-
te el desarrollo del proyecto, algunas tareas han sufrido variaciones en las
fechas de inicio y fin y en el trabajo realmente ejecutado con respecto a la
programacion inicial (A). Por otro lado, toma nota del avance de las tareas
(B). Esta informacion se refleja en la tabla 12.
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Actividad 5: Informes

Configurar el diagrama de Gantt de seguimiento en formato ppF, incluyendo
unicamente el nombre de las tareas, con la escala temporal del calendario a
nivel de detalle diario.

Generar los siguientes informes del proyecto a fecha de estado (quinto vier-
nes del proyecto):

— Detalle del proyecto (datos globales) y porcentaje completado hasta la
fecha de estado.

— Informacion de las tareas en relacion a costos.

— Informacion de las tareas en relacion a trabajo.

— Informacion sobre tareas criticas (cpm).

— Informacion de las tareas sobre seguimiento (7racking).

— Informacion de tareas en relacion a valor ganado.

— Quién hace qué.

Generar los histogramas de los recursos en cuanto a trabajo real ejecutado.
Generar los siguientes graficos:

— Flujo de caja comparativo entre el coste, el coste real y el de linea base
(Baseline Cost).

— Curva S del trabajo acumulado (Work) en relacién al de linea base
(Baseline Work).

— Histograma del coste acumulado que implica cada uno de los peones a lo
largo del proyecto.

Elaborar un documento con la informacion anterior que sintetice la evalua-
cion del proyecto en la fecha de estado.
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